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Introduction to CATIA
Learning Objectives
Upon completion of this lesson you will be able to: 

Understand the CATIA software.
Open CATIA.
Understand the CATIA interface.

1

4 Hours
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Each lesson in this course contains a case study, which 
explains the skills and concepts covered in the lesson. 
The case study will be described at the beginning of 
each lesson, and the student will be able to do the case 
study exercise once the theory for that lesson has been 
covered. 

Design Intent

Stages in the Process

Each case study contains a set of model 
requirements, known as the design intent. The first 
case study does not contain a design intent because 
you are not going to design anything. However, by 
the end of this lesson you should be able to:

Change the orientation of a model.
Change the visualization properties of a model.
Manipulate the specification tree.
Access the Help system of CATIA.

Part 
Design

Product 
Design

Generative 
Drafting

Exercises Exercises Exercises

Familiarization

Exercises

Master Project(Case Study)

Case Study

Each lesson consists of steps. You will go through 
the following steps to introduce yourself to CATIA:

1. Understand the CATIA software.
2. Open CATIA.
3. Understand the CATIA interface.
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CATIA is a mechanical design software. It is a 
feature-based, parametric solid modeling design 
tool that takes advantage of the easy-to-learn 
Windows graphical user interface. You can create 
fully associative 3D solid models, with or without 
constraints, while using automatic or user-defined 
relations to capture the design intent. 

CATIA acts as the backbone for concept, 
product definition, manufacturing, simulation, 
and after-market information found within 
various lifecycle stages of a product.
It provides the specifications and geometrical 
data related to a product across several lifecycle 
phases.

Open CATIA
Concept Planning Develop Qualify Launch SupportIn a Windows environment, you can start the 

CATIA application in several ways:

A. Select CATIA from the Start > Programs > CATIA menu.
B. Double-click the CATIA icon on your Windows desktop.
C.Double-click on an existing CATIA document.

Test

Maintenance

Analysis

Suppliers

Planning

Engineering

Simulation

Purchasing

CATIA Within the PLM Solution

CATIA’s Scope From Concept To Realization

Understand the CATIA software
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Understand the CATIA interface

A. Separate workbenches and their respective toolbars.

B. Easy navigation from one workbench to another.

C.Standard and specific menus & toolbars (File, Edit, 
Insert...).

D.Standard manipulations (Copy-Paste, Drag-and-
Drop, Edit in Place...).

E. Intuitive (highlighting, copilot, pointer shapes...).

F. Multi-document support.

G.Contextual menu (MB3) support.

H.Specification tree, which includes technological 
features, constraints, and relationships.

CATIA’s user interface adopts the Windows 
interface, and contains the following key features:

CATIA V5 is specifically designed for the Windows 
operating environment, and it behaves in the same 
manner as other Windows applications. Traditional 
menus provide access to all the CATIA commands. 
Toolbars contain icons for quick access to the most 
frequently used commands. 
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1

2

3

5

Rendering Styles

4

6

1

2

3

4

5

6

CATIA has the ability to apply different styles of 
rendering to visualize the geometry and provide 
more clarity to the model. 

View Tools

Shading (SHD)

Shading with Edges

Shading with Edges without smooth Edges

Shading with Edges with Hidden edges

Shading with Material

Wireframe (NHR)
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Case Study: Introduction to CATIA
Recap Exercise

20 min

In this exercise, you will review the master project assembly. With the knowledge you 
have learned in this lesson, you should be able to:

Change the orientation of a model

Change the visualization properties of a model

Manipulate the specification tree

Access the CATIA help system
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Case Study (1/6)
1. Open Introduction_Drill_Press.CATProduct.

2. Change the Orientation of the assembly.
a. Change the model orientation to Front.
b. Zoom in on the area as shown.

3. Change the Visualization properties.
a. Select the front face of the support part 

as shown and change the color to red.

1

3a

2b

2a
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Case Study (2/6)
4. Zoom out on the model.

5. Change to the Isometric view.

6. Change the rendering style to Wireframe.

7. Change the rendering style to Shading with Edges.

6

7

5
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Case Study (3/6)
8. Change the display of the specification 

tree.

a. Press the <F3> key to toggle the 
specification tree on and off. 

b. Select one of the branches of the 
specification tree and notice that 
the model darkens.

c. Try zooming out; notice that the 
specification tree is being 
manipulated and not the model.

d. Press <Shift> and <F3> to re-
activate the model.

8b
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Case Study (4/6)
8. Change the display of the specification tree 

(continued)

e. Expand the Casing_sup node of the 
tree. Notice that the features of the 
part are now displayed in the tree.

f. Collapse all the nodes to show only the 
top level of the tree.

8f

8e
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Case Study (5/6)
9. Review the areas of information.

a. Hover the mouse over the various tools 
and areas of the toolbars and notice the 
tool tip comments.

b. Review the message bar as you pause the 
mouse cursor over the icons for more 
information.

9b

9a
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Case Study (6/6)
9. Review the areas of information (continued).

c. Click Help > CATIA V5 Help.
d. A web browser launches, with the 

CATIA Help start page loaded. 
e. Spend few minutes browsing the 

various links within the system.

10. Close the assembly without saving changes. 

9d

9c
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Case Study: Introduction to CATIA Recap
Change the orientation of a model
Change the visualization properties of a model
Manipulate the specification tree
Access the CATIA help system
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Profile Creation
Learning Objectives
Upon completion of this lesson you will be able to: 

Create a new part. 
Select an appropriate sketch support.
Create sketched geometry.
Constrain the sketch.
Create the pad feature.
Save and close the document.

2

4 Hours
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The case study for this lesson is the support 
plaque used in the drill support assembly.

Design Intent
The model must be created in one feature.

While this is not typical practice, in this 
case it is a requirement.

The center hole must remain in the center of 
the support.

This requirement can be met by 
creating a rectangular profile 
symmetric about part origin and 
locating the center of the circle 
(representing the hole) at the origin.

The smaller holes must be 30mm away from 
the center hole.

Constraining the three small holes on a 
construction circle that is 60mm in 
diameter will ensure this requirement is 
met.

The model must be saved with the name 
Support_Plaque.

Case Study
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1. Create a new part. 
2. Select an appropriate sketch support.
3. Create sketched geometry.
4. Constrain the sketch.
5. Create the pad feature.
6. Save and close the document.

Stages in the Process
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When creating a new model, the Part Design 
workbench is activated. When a part is saved, it is 
saved with a .CATPart extension to distinguish it 
from other CATIA documents.
Use the following method to create a new part file:

Click Start > Mechanical Design > Part design.
Click File > New and select Part from the New 
dialog box.
Select the New icon from the Standard toolbar 
and select Part from the New dialog box.

A new part contains only three default 
reference planes. These default reference 
planes are always the first elements in the 
specification tree and are used as a basis for 
feature creation.

Create a New Part
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Every new part begins with a 2D profile. This 
profile can be created using the Sketcher 
workbench. The elements created within Sketcher 
are exclusively 2D WIREFRAME elements. In the 
Part Design workbench, the geometry created in 
Sketcher is seen as a single sketch. This sketch is 
used to create 3D features inside the Part Design 
workbench. 

A sketch support is the plane on which the sketch 
is created. The sketch support must be planar. 
You can create a sketch on a reference plane or 
on a planar face of any existing geometry. The 
default orientation of the model depends on which 
reference plane is selected for the sketch support. 

Sketches can be extruded 
to create solid geometry.

Sketch support

Sketch

Select an Appropriate Sketch Support
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The Sketcher workbench is an environment built to 
facilitate the creation of the 2D Profiles. The 
Sketcher workbench includes:

A. The Grid, which guides you while you create the 
profiles.

B. The Profile toolbar, which is used to create 
geometry.

C. The Constraint toolbar, which is used to 
constrain your sketch.

D. The Sketch Tools toolbar, that displays options 
available during geometry creation.

D

A
B

C

It is recommended to use a Positioned Sketch 
while creating a sketched profile. Do not to use 
Fillets, Chamfers and Drafts when creating 
sketched profile, because some of the 
manufacturing processes need to remove the 
Dress-Up features.

Create Sketched Geometry
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Constraints serve to mathematically fix 
geometry in space. Two types of constraints can 
be added to sketched geometry:

A. Geometric constraints, which specify how 
sketched elements are positioned with respect 
to each other and existing 3D geometry. 

B. Dimensional constraints, which specify the 
distance between two elements. This distance 
can be linear, angular, or radial.

Ideally, a completed sketch must be fully 
constrained. As you begin to create geometry, try 
to create it reasonably close in shape and size to 
the final constrained sketch. 

Constrain the Sketch

A

B
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Once the sketched profile has been created, solid 
3D geometry can be generated from it. A pad is a 
sketch-based feature that adds material to a 
model. 

Save and Close the Document

2D Profile (sketch) Extruded Pad
Documents need to be saved so that work is not lost. 
There are different ways to save CATIA documents:

Save
Save As
Save All
Save Management

Documents are saved:

With the same name (to replace the initial 
document).
Under a new name (to create a new 
document).

Documents can be saved:

After modifying them.
After creating new ones.

Create the Pad Feature
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1

2

3

User-Defined Profile: creates a sketched 
element as a construction element

Geometrical Constraints: controls whether 
geometric constraints are automatically created 
or not, during the development of the initial 
sketch

5

Sketch: creates a new sketch and opens 
sketcher workbench

Positioned Sketch: creates a new sketch and 
you can specify various parameter for sketch 
support

Sketcher 

4

Sketch Tools 

Grid: a grid is applied to the background of the 
Sketcher workbench

Snap to Point: the mouse pointer snaps to the 
points of the grid

6

1

2

3

4

5

6

Sketcher Tools
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Profile

User-Defined Profile: creates complex profiles 
consisting of straight line and circular arcs

Pre-defined Profiles: creates predefined 
profiles such as rectangle, parallelogram, 
hexagon etc. 

1

2

3 Circles: creates circles and circular arcs

4 Splines: creates splines and connecting curves

1

2

3

4

5

6

7Ellipses and Parabolas: creates conic curves 
such as ellipse, parabola, hyperbola etc.

Lines: creates predefined profiles such as 
rectangle, parallelogram, hexagon etc. 

5

6

7 Points: creates splines and connecting curves

Geometry Creation Tools
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Operation

Corner: create a corner shape between the two 
selected lines

Chamfer: Create a chamfer between the two 
selected lines

1

2

3 Constraint Defined in Dialog Box: creates 
geometrical constraints on selected elements

4 Constraint: quickly creates geometrical and 
dimensional constraints 

1

2

3

4

5

6

5

6

Constraint

Sketch-Based Features

Pad: extrudes a profile sketched in the 
Sketcher workbench. This command is 
available in Part Design workbench

Save: saves recent changes done in existing 
files and saves newly created files

Standard

Additional Tools
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Exercise: Profile Creation
Recap Exercise

15 min

By the end of this exercise you will be able to:

Create a new part

Access the Sketcher workbench

Create geometry using the Profile tool

Create a corner

Close the document without saving it

In this exercise you will create a sketched profile. High-level instruction for this exercise is 
provided.



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 33

Do it Yourself

1. Create a new part.

2. Create a Positioned Sketch using YZ plane 
as the Reference plane and access the 
Sketcher workbench.

3. Ensure that the automatic constraints 
(located in the Sketch Tools toolbar) are 
deactivated.

4. Create the profile (as shown) using the 
Profile icon.

5. Create the corner (this is a Style type of 
radius).

6. Close the document without saving it.

2

3

4

5
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Exercise Recap: Profile Creation

Create a new part file

Select the YZ plane as the sketch 
support

Create sketched geometry

Close the document without saving it

The sketch created in this exercise could 
be used to create a revolved feature, as 
shown above. You will learn how to create 
revolved features in Lesson 4.
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Exercise: Multiple Profile Creation
Recap Exercise

10 min

In this exercise you will create a profile consisting of several shapes. You will 
use the tools from previous exercises to complete this exercise.

By the end of this exercise you will be able to:

Create a new part

Access the Sketcher workbench

Create sketched geometry 

Close the document without saving it

CAUTION: To simplify the exercise, the sketch will contain several closed contours representing both the 
external shape of the 3D part (including fillets) and the internal forms (holes and pockets). Generally, for 
complex parts it is recommended that you simplify the sketches using dedicated 3D features like fillets, 
chamfers, holes, drafts, etc. to better fit the design and manufacturing intents.
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Do it Yourself 
1. Create the profile shown, using the ZX 

plane as the sketch support.

Conf. Dep.
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Exercise Recap: Multiple Profile Creation

Create the profile using a series of lines 
and arcs. 
Create the basic shape using the Profile
tool, then add corners and chamfers as 
separate operations.
Create the whole profile using the Profile 
tool.

You can create the outside profile in a number 
of ways: 

Conf. Dep.

Create a new part file

Select the ZX plane as the sketch 
support

Create sketched geometry

Close the document without saving it
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Exercise: Sketch Constraints 
Recap Exercise

15 min

In this exercise, you will fully constrain an existing sketch using the tools from the 
previous exercise. This exercise will help you understand how to constrain and 
dimension sketched entities. High-level instructions for this exercise are provided.

By the end of this exercise you will be able to:

Load an existing document

Constrain a sketch

Dimension a sketch

Use problem-solving skills

Save and close a model

CAUTION: Generally, for complex parts it is recommended that you simplify the sketches using dedicated 3D 
features like fillets, chamfers, holes, drafts, etc. to better fit the design and manufacturing intents.
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Do it Yourself (1/5)

1. Load the file.
Load Ex2E_1.CATPart. Once loaded, notice 
that sketches have already been created for 
you.

2. Edit the sketch.
Modify the sketch.1 in the Sketcher 
workbench by double-clicking on the sketch 
directly in the model or in the specification 
tree.

3. Add Horizontal constraints.

3

3

3
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Do it Yourself (2/5)
4. Add Tangency constraint.

Apply a tangency constraint between 
the bottom horizontal line and the arc.

5. Remove coincidence constraints which 
are not required.

54



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 41

Do it Yourself (3/5)

6. Add dimensional constraints.
Using proper techniques, add dimensional 
constraints to the sketch. Once all the 
dimensional constraints have been applied, 
the sketch will turn green, indicating that 
the sketch is fully-constrained.

6
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Do it Yourself (4/5)

7. Edit the sketch.
Modify the sketch.2 in the Sketcher 
workbench by double-clicking on the sketch 
directly in the model or in the specification 
tree.

8. Sketch in Context.
Project the edge of sketch.1 and keep it as a 
construction element. Add Concentricity 
constraint.

9. Add dimensional constraint.
Add 20mm diameter dimension to make 
sketch.2 fully-constrained. 

10. Add dimensional constraint.
Similarly, make sketch.3 fully-constrained.

8

9

10
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Do it Yourself (5/5)
11. Search and Load Ex2E_2.CATPart.

Load an existing part file. Once 
loaded, notice that sketches have 
already been created for you.

12. Edit the sketch.
Modify the sketches in the Sketcher 
workbench by double-clicking on 
the sketch directly in the model or 
in the specification tree.

13. Geometrically and dimensionally 
constrain the sketches.

Fully constrain the sketched circles 
with 20mm diameter dimensions as 
in the earlier instance. 

14. Compare sketches.
Were the sketches easier to 
constrain compared to the earlier 
instance? Why? 

15. Save and close both the documents.

13

11

13
13
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Exercise Recap: Sketch Constraints

Constrain the sketches

Dimension the sketches

Understand proper sketching 
techniques
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Exercise: Sketch Constraints
Recap Exercise

15 min

In this exercise you will fully constrain an existing sketch. You will use the tools 
learned in this lesson to complete the exercise with no detailed instructions.

By the end of the exercise you will be able to:

Open an existing model

Edit a sketch

Constrain an existing sketched geometry 

Save and close the document 

CAUTION: Generally, for complex parts it is recommended that you simplify the sketches using dedicated 3D 
features like fillets, chamfers, holes, drafts, etc. to better fit the design and manufacturing intents.
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Do it Yourself
1. Load Ex_2F.CATPart and fully constrain the sketch.
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Exercise Recap: Sketch Constraints

Constrain a sketch

Dimension a sketch
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Case Study: Profile Creation
Recap Exercise

10 min

You will practice what you have learned by completing the case study model 
using only a detailed drawing as a guidance.

The model must be created in one feature.

The model must be centered along the YZ and ZX planes.

The smaller holes must be 30mm away from the center hole.

The center hole must remain in the center of the support.

The model must be saved with the name Support_Plaque.

In this exercise, you will create the case study model. Recall the design intent 
of this model:

Using the techniques learnt so far, create the model without detailed instructions.
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Do It Yourself: Drawing of the Support Plaque
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Case Study: Support Plaque Recap

Create a new part file

Select the YZ plane as the sketch support

Create a sketch geometry

Constrain the sketch according to the design 
intent

Create a pad feature

Save and close the document
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Basic Features
Learning Objectives
Upon completion of this lesson you will be able to: 

Determine a suitable base feature. 
Create the pad and pocket features.
Create holes.
Create fillets and chamfers.

3

4 Hours
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Case Study
The case study for this lesson is the engine support 
used in the drill support assembly.

Design Intent
Internal loops must not be created in a sketch.

Each element on this model must be 
created as a separate feature. This makes it 
easy to make modifications in the future.

The four center holes must be created as one 
feature.

At first, one hole is created and then it is 
patterned to create the other three holes. 
Since the requirement is to have them 
created as one feature, a pocket must be 
used.

The fillets and the chamfer may need to be 
removed in downstream applications.

The fillets and the chamfer cannot be 
created within the sketched profile; they 
must be created as separate features.
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1. Determine a suitable base feature. 
2. Create the pad and pocket features.
3. Create holes.
4. Create fillets and chamfers.

Pad

Pocket

Pocket

Chamfer

Fillets

Coaxial hole

Stages in the Process
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Determine a Suitable Base Feature

When selecting a base feature, it is recommended 
to select the basic elements that convey the 
primary shape or function of the part. This does 
not mean the level of detail for a base feature must 
be completely defined. For example, fillets, holes, 
pockets, or other features need not be created as 
a part of the base feature sketch; these can be 
created later as separate features.
Use the following steps to create a base feature: 

Identify the part features.
Select one feature to represent the base 
element.
Identify the CATIA tools (features) needed to 
create it.
Create the feature.

Base Feature

The base feature usually starts from a sketch or 
a surface element. 
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Create the Pad and Pocket Features

A. A pad is a sketched-based feature that adds 
material to a model. 

B. A pocket is a sketched-based feature that 
removes material from a model. 

The profile sketch should consist of connecting 
entities that form a closed loop. Open loop profile 
sketches can be used only with the Thick option.

The length of a pad or pocket can be defined by 
dimensions or with respect to existing 3D limiting 
elements. If the pad/pocket feature is defined by a 
limiting element, it becomes associative to that 
element.

A

B

Sketch

Pad

Sketch

Pocket
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A hole removes circular material from an existing 
solid feature. A hole does not require a profile 
sketch. Like a pocket, its length can be defined 
using dimensions or with respect to the existing 3D 
elements. 
A hole can be created using the Pocket or Hole 
tool. The advantage of creating a hole using a Hole 
tool is that a sketch gets created automatically.
The Hole tool also allows you to include 
technological information, such as thread, angle 
bottom, and counter bore.
If there is a possibility that the profile for the cutout 
may change from circular to another shape then 
consider using a pocket instead of a hole.

Create Fillets and Chamfers
A fillet is a curved face of a constant or variable 
radius that is tangent to, and that joins, two 
surfaces. 

A chamfer replaces a selected edge by a flat 
section to create a beveled surface between 
the two original faces, which are common to 
that edge. 

Create Holes

Hole

Fillets

Chamfer
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1

2

3

5

Pad: adds material to a model by extruding a 
sketched profile

Pocket: removes material from a model by 
extruding a sketched profile

Hole: removes circular material from an 
existing solid model

Sketch-Based Features

4

Dress-Up Features

Edge Fillet: creates smooth transitional surfaces 
between two adjacent faces

Variable Radius Fillet: creates curved surfaces 
defined according to a variable radius

Face-Face Fillet: used when there is no 
intersection between the faces or when there are 
more than two sharp edges between the faces

Tritangent Fillet: removes one of the three faces 
which are selected

Chamfer: replaces a selected edge by a flat 
section to create a beveled surface 

6

7

8

1

2

3

Basic Features Tools

4

5

6

7

8

1
2 3

4

8
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Exercise: Basic Feature Creation
Recap Exercise

15 min

In this exercise you will open an existing part that contains a base pad 
feature. In the base feature you will create a pocket, a face-face fillet and 
chamfer. High-level instructions for this exercise are provided.

By the end of this exercise you will be able to:

Create a hole

Create a pocket

Create a face-face fillet

Create a chamfer
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Do it Yourself (1/4)

2

1

1. Open up the part Ex3B.CATPart.
Open an existing part file using the 
Open tool. The part file constrains 
two pad features.

2. Create four chamfers. 
Create chamfers on the four vertical 
edges of Pad.1.



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 60

Do it Yourself (2/4) 

3

3. Create a simple hole.
Create a simple hole using the pre-
defined references method.

Conf. Dep.
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Do it Yourself (3/4) 

44. Create a pocket.
Create an Up to Last pocket using 
the dimension shown.
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Do it Yourself (4/4) 

5

5. Create a face-face fillet.
Create a face-face fillet between 
surfaces on Pad.1 and Pad.2.

6. Save and close the file.
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Exercise Recap: Basic Feature Creation

Create a hole

Create a pocket

Create a face to face fillet

Create a chamfer
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Exercise: Basic Features Creation
Recap Exercise

10 min

In this exercise, you will create a part that contains features taught in this and 
the previous lessons. You will use the tools you have learned to complete the 
exercise with no detailed instructions. 

By the end of this exercise you will be able to:

Create a pad

Create a pocket

Create a countersunk hole

Create an edge fillet
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Do it Yourself
1. Create the following part.
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Exercise Recap: Basic Features Creation

Create a pad

Create a pocket

Create a countersunk hole

Create an edge fillet
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Exercise: Edge and Face-Face Fillets 
Recap Exercise

10 min

In this exercise you will create a part that contains features taught in this and 
the previous lessons. You will use the tools you have learned to complete the 
exercise with no detailed instructions. 

By the end of this exercise you will be able to:

Create a face-face fillet

Create the necessary additional fillet in order 
to enable face-face fillet creation
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Do it Yourself

Ex3D_A.CATPart Ex3D_B.CATPart

1. Add edge fillets to the top faces of the following parts.
2. Add face-face fillets by determining the radius yourself. Afterwards add 

bottom edge fillets.
3. Change the distance between the cylindrical / drafted pads and the 

preliminary edge fillet’s radius and examine the impact on the face-face fillet



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 69

Exercise Recap: Edge and Face-Face Fillets 

Create edge fillets in order to 
enable face-face fillet creation

Create face-face fillets
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Case Study: Basic Features
Recap Exercise

20 min

In this exercise you will create the case study model. Recall 
the design intent of this model:

The sketch must not contain any internal loops.

Each element on this model will need to be created as a separate feature. Creating the elements 
separately makes it easy to make modifications later.

The four center holes must be created as one feature.

One hole would be created first and then patterned to create the other three holes. Since the 
requirement is to have them created as one feature, a pocket will need to be used.

The fillets and the chamfer may need to be removed in downstream applications.

The fillets and the chamfer cannot be created within the sketched profile; they will have to be 
created as separate features.

Using the techniques discussed so far, create the model without detailed instructions.



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 71

Do It Yourself: Drawing of the Engine Support (1/2)
You will be required to create the following 
features:

1. Pad
2. Pocket
3. Coaxial hole
4. Pocket
5. Fillets
6. Chamfer

1

2

3

4

5

6
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Do It Yourself: Drawing of the Engine Support (2/2)
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Case Study: Engine Support Recap

Select a base feature

Create a pad

Create a pocket

Create holes

Create edge fillets

Create chamfers
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Additional Part Features
Learning Objectives
Upon completion of this lesson you will be able to: 

Create feature profiles and Axis system. 
Create Multi-profile Sketch Feature
Create basic wireframe geometry.
Create shaft and groove features.
Shell the model.

4 Hours

4
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The case study for this lesson is the Handle 
Block used in the Drill Press assembly.

Design Intent
The top and the bottom portions of the 
model must be created as separate 
features. 

The holes must be created at an angle to 
the XY plane.

The model must be hollow and must have a 
uniform thickness of 3mm, except the end 
which must have a thickness of 1mm.

The holes must be normal to the sides of 
the handle block.

Case Study

X-section of handle block

XY plane
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1. Create feature profiles and Axis system. 
2. Create Multi-profile Sketch Feature
3. Create basic wireframe geometry.
4. Create shaft and groove features.
5. Shell the model.

Stages in the Process
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Lesson 2 introduced you to the basic Sketcher 
tools and the Sketcher environment. This lesson 
will introduce you to the advanced Sketcher tools.
Sketcher includes the following additional tools:

Re-limitation tools
Transformation tools
Project 3D element tool
Analyze a sketch using the Sketch Analysis tool.

Multi-pads and pockets are features that create 
several pads/pockets in one operation. These tools 
require a sketch with at least two closed profiles. 
Consider using these tools as a fast way to create 
multiple features

Careful thought must be given to the profiles 
created in the sketch when they are used to define 
a Multi-Pad/Pocket. The profiles cannot intersect, 
they must form a closed loop to avoid feature 
definition error. 

Create Multi-profile Sketch Feature

Create Feature Profiles and Axis System 
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In the Part Design workbench, you have the ability 
to create points, lines, and planes outside of the 
Sketcher environment. These elements are called 
reference or 3D wireframe geometry.
Depending on how the part was initially created, 
these elements can be represented in the 
specification tree in two ways. If the Enable hybrid 
design option is selected, CATIA will place these 
features within the main PartBody. If the Enable 
hybrid design option is cleared, wireframe elements 
are inserted under a group called a Geometrical set. 
Geometrical sets contain only 3D wireframe and 
surface elements and not solid geometry.

Create Shaft and Groove Features
A revolved feature is created by revolving a 2D 
profile around an axis of revolution. In the Part 
Design workbench, you can create two types of 
revolved features:
The axis of revolution for a revolved feature 
can be created inside the sketch containing the 
profile, using the Axis tool. 
If you did not create an axis in the sketch you 
can define it from the Shaft/Groove definition 
window in the Axis selection field. Any linear 
element in the model can be used.

Create Basic Wireframe Geometry
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Shelling a feature hollows out solid geometry. The 
shelling operation removes one or more faces from 
the solid and applies a constant thickness to the 
remaining faces. You can also apply a different 
thickness to the selected faces.

While shelling a model, it is important to consider 
the feature order. The Shell operation hollows all 
solid features in a model. If you do not want a 
feature to be shelled, it must be created after the 
shell operation. 

Create Thin Features 
A thin feature is created by applying a constant 
thickness to a profile. The definition dialog 
boxes for pads, pockets, shafts, and grooves 
contain a section for defining a thin feature. 

A thin feature can be created with a closed 
or open profile. 
Thickness can be applied to one side or 
both sides of the profile.

Shell the Model
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1

2

3

Knowledge

Formula: creates Relationships between 
Dimensions

Equivalent dimensions: Equates all selected 
parameters to a value 

5

Relimitations: trim or extend the existing 
sketched geometry

Transformation: modify existing sketcher 
geometry

3D Geometry: project the existing 3D elements 
onto the sketch plane

Operation 

4

Tools 

Sketch Analysis: helps to resolve problems with a sketch

6

7

Tools

Axis System: used to define local coordinates

1

2

3

4

5

6

7

Additional Sketcher Tools
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1

2

4

5

6

3

7

1

2

Sketch-Based Features

4

3

Reference Elements 

5

Point: creates a point in 3D space 

Line: creates a line in 3D space 

Plane: creates a plane in 3D space 

Multi-pad: creates several pads in one operation

Multi-pocket: creates several pockets in one 
operation 

Shaft: helps to resolve problems with the sketch6

Dress-Up Features

7 Shell: removes one or more faces from the 
solid and applies a constant thickness to the 
remaining faces

Additional Part Design Tools
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Exercise: Sketch Analysis and Pocket
Recap Exercise

15 min

By the end of this exercise you will be able to:

Problem-solve a sketch

Use the Sketch Analysis tool

Create a pad using a sub-element of a sketch

Create a multi-pocket

In this exercise, you will open an existing part that contains a multi-profile sketch. You will 
use this sketch to create several features. High-level instructions for this exercise are 
provided.
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Do it Yourself (1/7) 

3

1. Open Ex4B.CATPart. 
Open an existing part file.

2. Create multi-pad feature.
Create the multi-pad feature using the 
sketch given. An error message 
appears, indicating that the sketch is 
not valid. Cancel the multi-pad creation. 

3. Edit the sketch.
Access the Sketcher workbench for 
Sketch.1 to investigate the sketch.

1

2
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Do it Yourself (2/7) 

4

5

4. Use the Sketch Solving Status Tool.
Use the Sketch Analysis tool to 
investigate what is wrong with the sketch. 
Although the sketch appears to be 
completely green (Iso-constrained), the 
status of the sketch is actually under-
constrained. Observe the highlighted 
points.

5. Access the Sketch Analysis tool.
Use the Sketch Analysis tool to further 
investigate the sketch.
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Do it Yourself (3/7) 

8

6

7

6. Review the geometry.
Select the Geometry tab. The sketch 
contains two open profiles and an 
isolated line.

7. Remove the constraints from the 
display.

To simplify the display, select the Hide 
Constraints icon.

8. Resolve the open profile.
Select the inside open profile and use 
the Close Opened Profile icon to 
resolve the issue.
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Do it Yourself (4/7) 

9

9. Resolve the isolated line.
Select the isolated line in the window. Observe 
where it is located in the model. This line should 
be a construction element. Use the Set in 
Construction Mode icon to convert the point.
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Do it Yourself (5/7) 

10

10. Review the second open profile.
Select the outer open profile from the 
window. Observe the area as shown. 
Zoom in; observe that the line is not a 
single entity but two entities. This is 
not correct. The Close Opened 
Profile option could be used to 
resolve this issue; however, the line 
would still be two separate entities. 
Instead, exit the Sketch analysis tool 
and resolve the issue using re-
limitation tools.
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Do it Yourself (6/7) 

11

12

11. Resolve the second open profile.
Delete one of the top lines. Use the 
Trim tool to extend the remaining line. 
Remember to add tangency between 
the line and the arc.

12. Re-analyze the sketch.
Return to the Sketch solving status 
window. The sketch should now be 
iso-constrained.
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Do it Yourself (7/7) 

13

13. Exit the sketcher and create the multi-
pad feature as shown.

14. Save and close the file.

Conf. Dep.

Conf. Dep.
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Exercise Recap: Sketch Analysis and Pocket

Problem-solve a sketch

Use the Sketch Analysis tool

Use re-limitation tools

Create a multi-pad feature
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Exercise: Multiple Profile Sketch Features
Recap Exercise

15 min

In this exercise, you will create a part that contains two features, a multi-
pad, and a multi-pocket. You will use the tools learned in this lesson to 
complete the exercise with no detailed instructions. 

By the end of this exercise you will be able to:

Create a multi-pad

Create a multi-pocket



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 93

Do it Yourself (1/2)

1

2

1. Multi-pad
2. Multi-pocket

You need to create the following features:
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Do it Yourself (2/2)
1. Create the following part.
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Exercise Recap: Multiple Profile Sketch Features

Create a multi-pad

Create a multi-pocket
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Exercise: Shaft and Groove
Recap Exercise

15 min

In this exercise you will create a new part. Using the shafts, grooves, and multi-pocket 
features, you will construct a pulley. High-level instructions for this exercise are 
provided.

By the end of this exercise you will be able to:

Create a shaft

Create a groove

Create a multi-pad



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 97

Do it Yourself (1/3) 

2

1. Create a new part file.
Create a new part file called 
[Ex4E.CATPart].

2. Create a shaft feature.
Use the dimension shown to construct a 
shaft feature.
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Do it Yourself (2/3) 
3. Create a groove feature.

Use the dimensions shown to create a groove feature. 
Remember to use the transformation tools while creating 
several identical profiles within one sketch. All profiles have 
the same internal dimensions.
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Do it Yourself (3/3) 

4

4. Create a multi-pocket feature.
Use the dimensions shown to create a 
multi-pocket feature.

5. Save and close the model.
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Exercise Recap: Shaft and Groove

Create a shaft feature

Create a groove feature

Create a multi-pocket feature
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Exercise: Shaft and Groove
Recap Exercise

15 min

In this exercise, you will create a part that contains features taught in 
this and the previous lessons. You will use the tools learned in this 
lesson to complete the exercise with no detailed instructions. 

By the end of this exercise you will be able to:

Create a shaft feature

Create edge fillets

Create internal and external groove features 

Create a pocket feature

Create a reference point and line

Create a cone-shaped groove feature
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Do it Yourself
1. Create the following spool part.
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Exercise Recap: Shaft and Groove

Create a shaft feature

Create edge fillets

Create internal and external groove features 

Create a pocket feature

Create a reference point and line

Create a cone-shaped groove feature
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Exercise: Pad, Fillet, Hole and Shell
Recap Exercise

20 min

By the end of this exercise you will be able to:

Create a pad

Create an edge fillet

Create holes

Create a shell feature

In this exercise you will open an existing part that contains a sketch. You will use this 
sketch to create a pad, fillet, and shell feature. High-level instructions for this exercise 
are provided.
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Do it Yourself (1/4) 

2

1
1. Open up the part Ex4H.CATPart.

Open an existing part file using the Open 
tool. The part file contains a sketch.

2. Create a pad.
Create a pad with a length of [175mm] 
using the existing sketch.
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Do it Yourself (2/4) 

3

3. Create edge fillets.
Create an edge fillet feature. Select the 
top surface and all the six vertical 
edges.



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 107

Do it Yourself (3/4) 

4
4. Create holes.

Create [50mm] diameter holes. Use the top 
of the pad as the starting surface and make 
them concentric to the two center radii. Set 
the depth to cut through the entire pad.

Conf. Dep.
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Do it Yourself (4/4) 

5
5. Create a shell feature.

Create a Shell and select the bottom surface 
to be removed and specify a thickness of 
[5mm] for the inside thickness.
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Exercise Recap: Pad, Fillet, Hole and Shell

Create a pad

Create a fillet

Create holes

Create a shell feature
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Exercise: Thin Pad, Shell and Holes
Recap Exercise

10 min

By the end of this exercise you will be able to:

Create pads

Create a shell

Create a thick pad

Create holes

Create a chamfer

In this exercise you will create a part that contains features taught in this and the previous 
lessons. You will use the tools learned in this lesson to complete the exercise with no 
detailed instructions. 
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Do it Yourself
Create the following part.
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Exercise Recap: Thin Pad, Shell and Holes

Create pads

Create a shell

Create a thick pad

Create holes

Create a chamfer



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 113

Case Study: Additional Part Features
Recap Exercise

20 min

In this exercise you will create the case study model. 
Recall the design intent of this model:

The top portion and bottom portions of the model must be created as separate features.

The holes must created at an angle to the XY plane.

The model must be hollow.

The holes must be drilled normal to the sides of the handle.

Using the techniques discussed so far, create the model without detailed instructions.
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Do It Yourself: Drawing of the Handle Block (1/4)

2

1

You will need to create the following features:

1. Create a multi-pad feature.
Create the bottom section of the model 
with the Multi-pad tool.

2. Create a revolve feature.
Create the top section of the model 
using a revolve feature.



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 115

Do It Yourself: Drawing of the Handle Block (2/4)

3

4

5

You will need to create the following features 
(continued):

3. Create a groove.
Create a cut using the Groove tool. Use the 
Project 3D tools to associate the cut to the 
revolve feature.

4. Create a plane.
Create a plane [45] degrees from the XY plane.

5. Create holes.
Create holes that are coincident with the user-
defined plane.
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Do It Yourself: Drawing of the Handle Block (3/4)

6
8

8

8

You will need to create the following features
(continued):

6. Create a pocket.
Create the sketch for the pocket by 
creating one profile, use the Rotate tool to 
create the remaining three profiles.

7. Shell the model.
Shell the model to a thickness of 2mm, 
except at the bottom where the thickness 
should be different (see the drawing).

8. Create dress-up features.
Complete the model by adding a 5mm fillet 
to the top edge and a 1mm x 45 degree 
chamfer to the two edges shown.
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Do It Yourself: Drawing of the Handle Block (4/4)
Use the dimensions shown to complete the Handle Block part.



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 118

Case Study: Handle Block Recap

Create a multi-pad feature

Create a shaft feature

Create a groove feature

Create reference geometry

Create holes

Create a pocket

Shell the model

Create dress-up features
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Dress-Up Features
Learning Objectives
Upon completion of this lesson you will be able to: 

Apply a draft
Create a stiffener
Create threads and taps
Edit features

4 Hours

5
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The case study for this lesson is the Casing used 
in the Drill Press assembly.

Design Intent

The inner ribs of the Casing should be created 
using Stiffener features.

Stiffener features provide the most 
efficient method of creating this geometry.

The Casing should have a 4 degree draft.
This part would most likely be 
manufactured using the Molding process, 
which requires drafts.

The Casing should have taps defined for all 
the holes.

Taps can be represented in a simple 
manner without having to create the 
complex geometry, which can be time-
consuming and resource-intensive during 
regeneration cycles.

Case Study
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1. Apply a draft.
2. Create a stiffener.
3. Create threads and taps.
4. Edit features.

1

2

3

Stages in the Process
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Draft features are used to apply an angle to a part 
surface relative to some reference. Material is 
added or removed depending on the draft angle and 
the pull direction applied during the operation.

Whenever possible, use the same reference for 
the parting and neutral elements. Doing so can 
often avoid unexpected geometry. 
Whenever possible, create parts in the following 
general order:

1. Main part features 
2. Drafts
3. Fillets
4. Shells
5. Minor part features

Apply a Draft

1

4

2 3

5 5

Create a Stiffener
In CATIA, stiffeners are created by extruding and 
thickening an open-sketched profile.

A.From Side
The sketch is extruded in the profile plane and 
thickened normal to it.

B.From Top
The sketch is extruded normal to the profile plane 
and thickened in the profile plane.

A
B
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A thread is a helical groove outside of a cylindrical 
shaft, while a tap is a helical groove inside a 
cylindrical hole.

In CATIA, the actual geometry of threads and 
taps is not displayed. It is represented on the 
part cosmetically. 
The features contain parameters that define the 
intended thread and tap geometry, such as 
diameter, pitch, and depth.  
It can also be displayed in a drawing view.

Edit Features

Thread

Tap

Feature editing and manipulation, beyond 
dimension changes, is often required as design 
intent changes or modeling strategies evolve. 
CATIA has several functionalities that enable you 
to edit features,

Create Threads and Taps

Define in work object
Reorder features
Properties
Filters (Search)
Parent-child relationships
Resolve feature failures
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1

2

3

4

Sketch-Based Features

Stiffener: Creates a stiffener by extruding and 
thickening an open-sketched profile.

5

1

2

3

4

5

Draft Angle: Creates a basic draft.

Draft Reflect Line: Creates drafts on non-
planar surfaces, such as a cylinder.

Variable Angle Draft: Creates a draft that has 
different angles at transition edges.

Thread/Tap: Applies threads or taps on shafts 
or holes.

Dress-Up Features

Main Tools
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Exercise: Reflect Draft
Recap Exercise

20 min

In this exercise you will practice creating drafts. High-level instructions for this 
exercise are provided.

By the end of this exercise you will be able to:

Create a basic draft

Create a reflect draft

Conf. Dep.
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Do it Yourself (1/5)
1. Create a new part.

Create a new part with the geometrical set.
2. Create a shaft.

You will create a sketch of the shown profile 
and use that to create a shaft feature.

a. Create the sketch on the YZ plane.
b. Create a 360° shaft feature.

2

1
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Do it Yourself (2/5)
3. Create a basic draft.

a. Select the walls of the cylinder as the faces to draft 
and the top surface as the neutral and pulling 
direction.

b. Specify a [6deg] draft angle.

3
Conf. Dep.
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Do it Yourself (3/5)
4. Create a Reflect draft.

a. Create an offset datum plane that is [100 
mm] from the xy plane in the negative 
direction. 

b. Select the face of the cylinder to apply 
the reflect draft. 

c. Click OK on the Feature Definition 
Error.

d. Define the parting element as the offset 
plane created earlier.

e. Define the pulling direction as the offset 
plane created earlier.

f. Ensure that the pull direction is correct.
4c

4d
4e

4b

4f

Conf. Dep.
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Do it Yourself (4/5)
5. Create a pocket.

a. Select the top surface of the pad and sketch the 
following profile. Use the existing face of the pad to 
create a [10mm] offset. 

b. Create a pocket that is [50mm] deep.

5a

5b
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Do it Yourself (5/5)
6. Create an edge fillet.

a. Select the edges around the top and 
bottom profiles and specify a [5mm] 
radius value.

7. Hide all the references plane.

8. Save and close the file.

6a

Conf. Dep.
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Exercise Recap: Reflect Draft

Create a basic draft
Create a reflect draft Conf. Dep.

Conf. Dep.
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Exercise: Stiffeners and Draft
Recap Exercise

10 min

In this exercise you will use the new skills you have acquired to create a part that 
contains a draft and four stiffeners. You will use the tools used in the previous 
exercises to complete this exercise with no detailed instructions.

By the end of this exercise you will be able to:

Create a new part

Apply draft to a part

Create stiffeners
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Do it Yourself
1. Create the part shown below.
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Exercise Recap: Stiffeners and Draft

Create a new part
Apply draft to a part
Create stiffeners



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 135

Exercise: Thread
Recap Exercise

10 min

In this exercise you will create a bolt and complete the exercise with the techniques 
and tools you have already learned, without any detailed instructions.

By the end of this exercise you will 
be able to:

Create threads.
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Do it Yourself
1. Create the bolt part with the dimensions given below.
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Exercise Recap: Thread
Create threads
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Exercise: Features Activation
Recap Exercise

10 min

In this exercise you will open an existing part and investigate how it was modeled. 
High-level instructions for this exercise are provided.

By the end of this exercise you will be able to:

Review the specification tree

Hide features

Activate features
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Do it Yourself (1/2) 

3

1. Load Ex3E.CATPart.

2. Review the specification tree.
Review the specification tree and 
note the hidden and deactivated 
features.

3. Hide the default reference planes.
The reference planes are no longer 
required to simplify the display. Hide 
them from visible space.
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Do it Yourself (2/2) 

4

4. Activate the edge fillets.
The last three features in the 
specification tree have been deactivated. 
Activate these features.

5. Close the model.
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Exercise Recap: Features Activation

Review a specification tree

Hide features

Activate features
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Exercise: Update Error Management
Recap Exercise

20 min

In this exercise, you will open an existing part file, update it and resolve any feature 
failures that may occur. High level instructions for this exercise are provided.

By the end of this exercise you will be able to:

Troubleshoot a part that contains features that fail.
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Do it Yourself (1/3)

1

2

In this exercise, you will open an existing part file, 
update the part and resolve any feature failures.

1. Open Ex5e_error.CATPart.
Open an existing part file using the 
Open tool and investigate the features 
in the specification tree.

2. Update the model.
The icons in the specification tree 
specify that model needs to be 
updated .
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Do it Yourself (2/3)
3. Resolve feature failures.

Once CATIA tries to regenerate Pad.3, 
sketch.3 fails. CATIA prompts you to edit the 
sketch. Review the sketch and make a note of 
the missing references. Delete them and exit 
the sketcher workbench.

3
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Do it Yourself (3/3)

4

4. Resolve feature failures (continued).
The second feature failure occurs 
because of an update cycle error 
between features Pad.5 and 
Shell.1. After reviewing the 
features, Shell.1 needs to be 
reordered to occur before Pad.5. 

a. Deactivate Pad.5 and then 
reorder Shell.1 to occur before it.

b. Select Deactivate in the Update 
Diagnosis dialog box. Hole.2 and 
Hole.3 also need to be 
deactivated since they are 
children of Pad.5.

c. Reorder Pad.5 to appear after 
Shell.1, since the Sketch for 
Pad.5 needs a face from Shell.1 
feature.

d. Activate all the three features that 
were deactivated.

5. Save and close the file.

Conf. Dep.
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Exercise Recap: Update Error Management
Troubleshoot a part that contains features 
that fail.
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Case Study: Dress-up Features
Recap Exercise

25 min

You will practice what you learned by completing the case study model using 
only a detailed drawing and hints as guidance.

In this exercise you will create the case study model. Recall the design intent of 
this model:

The inner ribs should be created using stiffener features.

The casing should contain a four degree draft.

The casing should have taps defined for any holes.

Using the techniques discussed in this and the previous 
lessons, create the model without detailed instructions.
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Do It Yourself: Drawing of the Casing
Create the model using the drawing provided here.
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Case Study: Casing Recap

The inner ribs should be 
created using stiffener 
features.

The casing should contain 
a four degree draft.

The casing should have 
taps defined for any holes.
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Reusing Data
Learning Objectives
Upon completion of this lesson you will be able to: 

Duplicate Features
Transform a Body
Copy and Paste the Data
Insert Data From a Catalog

4 Hours

6
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The case study for this lesson is the Engine used 
in the Drill Press assembly.

Design Intent
A. The side fins must be created using a 

rectangular pattern.
This avoids having to create and sketch 
each pocket individually.

B. The hole pattern must be created using a user-
defined pattern.

This feature can also be created as a 
rectangular pattern; however, a user-
defined pattern will enable you to 
customize the hole locations.

C. The model must be partially created by copy 
pasting the features. 

This is one way of quickly recreating 
duplicate features.

D. The model must include features from a 
catalog.

This is an easy method to retrieve data 
from a source that is accessible to 
everyone.

A

B

C

D

Case Study
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1. Duplicate Features
2. Transform a Body
3. Copy and Paste the Data
4. Insert Data From a Catalog

Stages in the Process
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In order to avoid creation of each feature 
individually, duplication tools are used. Two types 
of duplication features:

A

B

Duplicate Features

A. Mirror: While designing parts, it is better to 
identify areas of symmetry before you start 
making the model. This enables you to plan and 
reduce the amount of work needed by only 
building half of the part, then using the Mirror 
tool to build the other side. 

B. Pattern: Using Patterns you can create several 
identical features from an existing one and 
simultaneously position them on a part. Three 
different types of patterns are:

i. Rectangular patterns are linear and can 
be created in two directions. 

ii. Circular patterns are radial and defined 
about an axis. 

iii. User patterns use an existing sketch of 
points to define the location of the 
instances. 



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 155

Transformations are used in a multi-body 
context. Transformations are required when you 
have some geometry that has been created in 
one location and which needs to be moved into a 
specific position. These transformations enable 
you to move a body by translating it along an 
axis, rotating it round an axis, or moving it 
symmetrically about a plane.
The Scaling option allows to shrink or expand an 
entire body based on a single reference. In the 
design of the model for an injection molded 
plastic part, the design part will often be scaled 
up, to account for material shrinkage. 

Translate

Rotate

Symmetry Scaling

Transform a Body
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Features can be duplicated by copying and pasting 
them within a part. The pasted feature is identical 
and completely independent of the original feature. 
To copy and paste, you can use any one of the 
following techniques:

Paste on 
the flank

Copy the hole

Copy and Paste the Data

Click Copy then Paste in the Standard toolbar 
Select Edit > Copy then Edit > Paste
Press Ctrl+C and then Ctrl+V
Right-click then select Copy and Paste, or 
In the geometry area or the specification tree, 
press and hold down the Ctrl key and drag the 
selection and drop in the geometry area or the 
specification tree. 
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Catalogs are sets of frequently used features or 
components which are stored as a library of 
information. You can retrieve these features or 
components to avoid recreating geometries. 

Catalogs can be built of two types of features:

A.User Feature is a group of features that exists 
as one entity and when placed in a model, it is 
represented by a single feature. 

B.PowerCopy is also a group of features that 
exist as one entity. However, when placed in a 
model the original order and the state of the 
features are preserved. This makes it easy to 
modify the features after placing the 
PowerCopy.

Insert Data From a Catalog
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1

2

3

4

Patterns

5

Transformations

Translate: moves a body in a linear direction

Rotate: rotates a body around a selected axis

Symmetry: mirrors a body without duplicating it

Mirror: duplicates selected features across a 
reference plane to create mirror effect

6

7

8

Rectangular Pattern: creates array of selected 
features in linear directions

Circular Pattern: creates array of selected 
features in radial directions

User Pattern: creates array of selected 
features using locations defined in an existing 
sketch of points

Scaling: shrinks or expands an entire body 
based on a given ratio

Reusing Tools

1

2

3

4

5

6

7

8
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Exercise: Patterns
Recap Exercise

15 min

In this exercise you will practice creating and manipulating patterns. High-level 
instructions for this exercise are provided.

By the end of this exercise you will be able to:

Create a rectangular pattern

Remove instances from a pattern 

Explode a pattern

Modify an instance of the pattern

Conf. Dep.
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Do it Yourself (1/3) 
1

2

You will be opening up an existing part, 
creating a rectangular pattern, removing some 
instances, exploding the pattern, and 
modifying some instances of the pattern.

1. Open the file Ex6B.CATPart.
2. Create a rectangular pattern of 

Pocket.1.
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Do it Yourself (2/3) 
3. Remove the following instances from 

the pattern.
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Do it Yourself (3/3) 
4. Explode the pattern.

5. Modify the two pockets as per the 
following sketch.

6. Save and close the file.

Conf. Dep.

4

5
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Exercise Recap: Patterns

Create a rectangular pattern

Remove instances from a pattern

Explode a pattern

Modify an instance of the pattern

Conf. Dep.
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Exercise: Patterns
Recap Exercise

25 min

In this exercise  you will use the newly acquired skills to create a part containing a 
circular pattern. You will use the tools used in the previous exercises to complete this 
exercise with no detailed instructions. 

By the end of this exercise you will be able to:

Create a new part

Create a circular pattern
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Do it Yourself
Create the part as shown below:
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Exercise Recap: Patterns
Create a new part

Create a circular pattern 
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Exercise: Patterns Modifications
Recap Exercise

10 min

In this exercise you will modify an existing pattern by exploding and removing 
instances. You will also copy and paste one of the exploded instances and make 
changes in the copied feature. High-level instructions for this exercise are provided.

By the end of this exercise you will be able to:

Explode a pattern

Remove instances of the pattern

Copy and paste features

Modify the copied features

Conf. Dep.
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Do it Yourself (1/3) 

1

2

2

In this exercise, you will open an existing part 
file and manipulate instances of a pattern.

1. Open Ex6Econeholder.CATPart.
Open an existing part file using the 
Open tool and investigate the features in 
the specification tree.

2. Edit the pattern and remove instances.
Remove two instances of the pattern by 
clicking on the pattern instance dots. 
Note that the fillet feature will fail 
because it was created after the pattern 
feature. Removing instances of the 
pattern will also remove references for 
the fillet feature. Select Edgefillet.10, 
select Edit, and click OK to remove the 
missing references. Click OK on the 
Edge Fillet definition dialog box.
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Do it Yourself (2/3) 

3

5

4

3. Explode the pattern.
Explode the pattern and notice that the fillet 
and shell features that were created after 
the pattern are not deleted.

4. Copy and paste an instance.
Copy Pad.2 and paste it into the same part. 

5. Modify the copied instance.
Edit the sketch of the copied pad and move 
the sketch to the centre of the part. Change 
the pad length to [100mm].

Conf. Dep.
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Do it Yourself (3/3) 

6

6. Add a draft and fillet to the instance.
Add an [8 degree] draft and [5mm] 
fillets to the copied instance.

7. Save and close the part.
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Exercise Recap: Patterns Modifications

Remove pattern instances

Explode pattern

Copy and paste a pad instance

Modify the copied pad

Create a draft and fillets

Conf. Dep.
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Exercise: Pattern and Catalog
Recap Exercise

30 min

In this exercise you will create a phone model. You will use the tools learned in this 
lesson to complete the exercise with no detailed instructions. 

By the end of this exercise you will be able to:

Create a pattern

Remove instances of a pattern

Insert a feature from a catalog
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Do it Yourself 

Z

X

Y
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Exercise Recap: Pattern and Catalog
Create a pattern
Remove instances of a pattern
Insert a pocket feature from a catalog
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Case Study: Reusing Data
Recap Exercise

35 min

You will practice what you have learned by completing the case study model 
using only a detailed drawing and hints as guidance.

In this exercise you will create the case study model. Recall the design intent of 
this model:

The side fins should be created by a rectangular pattern

The hole pattern should be created by a user pattern

The model should be partially created by copying and pasting features 

The model should include features from a catalog

Using the techniques discussed so far, create the model 
without detailed instructions.
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Do It Yourself: Drawing of the Engine (1/3)
The following steps offer useful hints to guide 
you through the creation of the engine part:

1. Open CaseStudy.CATPart.

2. Create a rectangular pattern for the side fins.

3. Create a user pattern for the hole pattern.



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 177

Do It Yourself: Drawing of the Engine (2/3)

5

The following steps offer useful hints to guide you 
through the creation of the engine part (continued):

4. Create copies of Pad.3, Pad.5 and 
Hole.1 one after the other and 
paste them one by one into the 
model.

5. Move the pasted features into a 
separate body by selecting the 
features, and selecting Insert In 
New.. from the contextual menu.

6. Translate the body to a distance of 
[40] in the X direction.

Conf. Dep.
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Do It Yourself: Drawing of the Engine (3/3)
The following steps offer useful hints to guide you 
through the creation of the engine part (continued):

7. Insert data from the supplied CaseStudy.catalog. 

8. Reorder the catalog Shaft feature to occur before 
Pocket.4 in order to apply the pocket feature to the 
catalog geometry.
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Case Study: Engine Recap

The side fins should be created by a rectangular 
pattern

The hole pattern should be created by a user-
defined pattern

The model should be partially created by copying 
and pasting the features

The model should include features from a catalog
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Finalizing Design Intent
Learning Objectives
Upon completion of this lesson you will be able to: 

Apply Material Properties
Analyze the Model
Create Formulas and Parameters

4 Hours

7
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L

The case study for this lesson is the table used 
in the Drill Support assembly.

Design Intent
The model must be made of aluminum.

• The material selected for this part is 
aluminum. The material properties of 
aluminum in the CATIA library will meet 
the requirements.

Model geometry must adhere to the following 
criteria (which can be verified using 
measurement tools and enforced using 
formulas):

a. Create a hole that is always 2mm above 
the bottom oblong holes and is centered 
horizontally.

b. Overall width must be 80% of the length 
(L).

c. The thickness of the model is always 1% 
of the length (L).

d. The thickness of the ribs is two times the 
thickness of the model.

a

b

L

c

d

Case Study
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1. Apply Material Properties
2. Analyze the Model
3. Create Formulas and Parameters

Stages in the Process
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In CATIA you can apply material to any part. 
These material properties (e.g., density) affects the 
mass of the part. These properties play important 
role in the structural and thermal analyses of the 
part.
CATIA has a default library of materials already 
installed. Your company may have custom 
materials created to conform to your requirements.
You can render the material on the model using a 
customized view mode or shading with material 
mode. 

There are three types of measure modes:

Analyze the Model

A. The Measure Between tool 

B. The Measure Item tool

C. The Measure Inertia tool

All measurements can be saved in the 
specification tree by selecting the Keep Measure 
option. All measurement tools have an option to 
create a geometry. Points, lines, and axis systems 
related to measurement can be created to illustrate 
the measurement. This is called as measurement 
geometry.

Properties 
important for 
thermal and 
structural 
analyses

Rendering 
after applying 
material.

First 
point

Second point

Line

Measurement 
Geometry

Apply Material Properties
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All features and elements in CATIA are unique. 
Once the features are created, they receive a 
unique identifier (parameter). These parameters 
can be used to create formulas. Formulas are 
equations that relate one parameter to another and 
ensure that the design intent is maintained. 
Formulas are stored under the Relations branch of 
the specification tree. 

In addition to system generated parameters you 
can create new parameters. Such parameters are 
called as User-Defined parameters. User-Defined 
parameters are isolated until they are related to 
some geometric parameter in the model. User-
defined parameters are stored under the 
Parameters branch of the tree.

It is important to consider units when you write 
formulas. If units are not specified in a formula, the 
default unit is used (i.e., meters). This is 
particularly important if you are adding or 
subtracting a numerical value.

Create Formulas and Parameters
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1

2

3

Material

4

Measure

Measure Between: measures the distance 
between the elements in a model

Measure Item: measures a specific element in 
a model

Measure Inertia: calculates the mass 
properties of the model

Apply Material: applies material to any part in CATIA

Knowledge

5 Formula: creates new user-defined parameters 
and creates relation between different 
parameters

1

2

3

4

5

Main Tools
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Exercise: Material and Measures
Recap Exercise

15 min

In this exercise you will use the measurement tools to determine specific dimensions 
on an existing model. High-level instructions for this exercise are provided.

By the end of this exercise you will be able to:

Apply material to a model

Take measurements

Calculate mass properties



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 188

Do it Yourself (1/2) 
1. Open Ex7B.CATPart.

2. Apply Iron material to the model.

3. View the applied material.

4. Determine the width of the part.

2

3

4

Width
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Do it Yourself (2/2) 
5. Calculate the distance between the three 

center points of the three holes.

6. Determine the mass of the model.

7. Measure the angle as shown.

8. Save and close the file.

6

5

7
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Exercise Recap: Material and Measures

Apply material to a model

Take measurements

Calculate mass properties
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Exercise: Parameter and Formula
Recap Exercise

20 min

In this exercise you will practice maintaining design intent by creating 
formulas and parameters. You will use the tools used in the previous 
exercises to complete this exercise. High-level instructions for this exercise 
are provided.

By the end of this exercise you will be able to:

Create formulas

Create user-defined parameters
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Do it Yourself (1/7) 
1. Open Ex7D.CATPart.

Open an existing part file using the Open tool.

2. Review the model.
Review the model creation. Are there any existing formulas?
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Do it Yourself (2/7) 

3

3

Width

Length

3. Control all Pad.1 dimensions with the width.
Create formulas so that changing the width of 
pad.1 also updates the radius and the length. 
The radius should be 8% of the width and the 
length should be 75% of the width.
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Do it Yourself (3/7) 

4

Outside radius

4. Create a formula.
Create a formula to link the diameter of 
the co-axial hole with the outside 
radius. The co-axial hole’s diameter 
should be two- third (2/3) of the outside 
radius.
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Do it Yourself (4/7) 
The next two steps are used to create a formula 
that controls the radius of EdgeFillet.2 based on 
the arc length of EdgeFillet.1.

5. Measure arc length of the edge fillet.
In order to use a measurement in a 
formula, you must create the measurement 
before creating the feature where you want 
to use it. As a workaround, define 
EdgeFillet.1 as the object and take the 
measurement. By doing this, the 
measurement comes before EdgeFillet.2 in 
the regeneration cycle:

a. Right-click on EdgeFillet.1 and select 
Define in Work Object.

b. Calculate the arc length of EdgeFillet.1. 
You will need to customize the 
measurement to calculate the length.

c. Save the measurement in the 
specification tree.
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Do it Yourself (5/7) 

6

6. Create a formula.
Create a formula that equates the 
radius of EdgeFillet.2 to one-third (1/3) 
the arc length measured in the last 
step.
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Do it Yourself (6/7) 

7

8

7. Create a user-defined parameter.
Type = [Length] 
Name = [Width] 
Value = [200mm]

8. Equate the width of the part to the 
new Width parameter.

Set the Width dimension 
(PartBody\Sketch.1\Offset.28\Offset) 
of Pad.1 equal to the new parameter.
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Do it Yourself (7/7) 
9. Test the model.

Change the Width parameter to [150mm] and change the radius of EdgeFillet.1 
to [5mm]. Update the model. Did the model update as expected?

10. Save and close the file.
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Exercise Recap: Parameter and Formula

Create formulas

Create user-defined parameters
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Exercise: Parameter and Formula
Recap Exercise

15 min

In this exercise, you will create formulas and parameters to control 
dimensions in the model. You will use the tools you have learned in this 
lesson to complete the exercise with no detailed instructions. 

By the end of this exercise you will be able to:

Rename parameters

Create formulas

Create user-defined parameters
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Do it Yourself (1/3)

2b

2c

2f

2a

2d

2e

1. Open Ex_7E.CATPart.
2. Rename the following parameters to create the formulas:

Current Name
PartBody\Pad.1\FirstLimit\Length

PartBody\Sketch.1\Offset.41\Offset

PartBody\Sketch.1\Radius.13\Radius

PartBody\Sketch.1\Radius.14\Radius

PartBody\Hole.2\Diameter

PartBody\EdgeFillet.2\CstEdgeRibbon.16\Radius

Thickness

New Name

Pad.1 Length

SmallArc Radius

LargeArc Radius

Hole Diameter

Fillet Radiusf.

e.

d.

c.

b.

a.
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Do it Yourself (2/3)
3. Create a parameter.

Type = [Length]. 
Name = [Length]. 
Value = 180mm].

4. Create the following formulas:
LargeArc Radius = 10% of Length.
SmallArc Radius = 2/3 LargeArc Radius.
Thickness = 2.5% Length.
Hole Diameter = LargeArc Radius.
Fillet Radius = ½ Thickness.
Pad.1 Length = Length.
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Do it Yourself (3/3)

5b

5a

5. Test the model.
a. Change the length parameter to a value of 

[300mm]. 
b. Use the Measurement tool to calculate the 

new distance between the center of the 
large arc and the center of the small arc.
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Exercise Recap: Parameter and Formula

Rename parameters

Create formulas

Create user-defined parameters
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Case Study: Finalizing Design Intent
Recap Exercise

30 min

You will practice what you learned by completing the case study model using 
only a detailed drawing as a guidance.

In this exercise, you will create the case study model. Recall the design intent of 
this model:

The model must be made of aluminum.

Create a hole that is centered on the part horizontally and 2mm above the top of the 
bottom oblong holes.

When modifications are made to the model:

Overall width must be 80% of the length (L).

Thickness of the model is always 1% the length (L) of the model.

The thickness of the ribs is 2 times the thickness of the model.

Using the techniques discussed so far, create the model without detailed instructions.
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Do It Yourself: Finalizing Design Intent (1/5)

Formula1

1. Open CS_L7.CATPart.
2. Create a 20mm diameter hole with the 

following requirements:
Hole must remain 2mm above the top of 
the bottom oblong holes.

a. To do this, you can create a 
measurement to calculate the distance 
from the bottom of the model to the top 
of the bottom oblong holes. For the 
measurement a point has already been 
created.

Hole must remain centered horizontally 
on the model. 

a. This model has been created symmetric 
about the YZ plane.

Use the following steps as hints to create the 
model:
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Do It Yourself: Finalizing Design Intent (2/5)

Length

Formula2

3. Rename the parameters and create formulas to maintain the required design 
intent. The completed model is shown.
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Do It Yourself: Finalizing Design Intent (3/5)

Length

Formula3
Formula4

4. Rename the parameters and create formulas to maintain the required design 
intent. The completed model is shown.
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Do It Yourself: Finalizing Design Intent (4/5)
5. Calculate the volume and mass of the model. Create an associative point at the 

center of gravity.
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Do It Yourself: Finalizing Design Intent (5/5)
6. Modify the length of the model to [500mm]. Calculate the distance between the 

center oblong hole and the side wall.
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Case Study: Finalizing Design Intent Recap

Apply material to the model

Calculate mass properties

Create formulas

Take measurements
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Assembly Design
Learning Objectives
Upon completion of this lesson you will be able to: 

Create a New CATProduct
Assemble in the Base Component 
Manipulate the Position of the Component
Assemble & Fully Constrain Components
Save the Assembly

4 Hours

8
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The case study for this lesson is the handle 
mechanism sub-assembly.

Design Intent
Fix the first component. 

• Although fixing the first component is not 
essential in CATIA, it is considered as a 
good practice.

Fully constrain all components.
• Fully constraining the components is a 

good way to avoid undesired changes. 
Reuse existing components.

• Reusing the existing components 
decreases the design time.

Case Study

Stages in the Process
1. Create a New CATProduct
2. Assemble in the Base Component 
3. Manipulate the Position of the Component
4. Assemble & Fully Constrain Components
5. Save the Assembly
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A product is an assembly document that stores a 
collection of components (parts or other 
assemblies). It uses the .CATProduct extension. 
The components used in an assembly can be pre-
existing components or components created within 
the assembly. Like a part, a product contains a 
specification tree. The tree shows the inserted 
components, and the constraints used to fix the 
components. Products are created in the 
Assembly Design workbench. 

Create a New CATProduct
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You can add a component to an assembly in one 
of the three ways: 

A. Contextual menu: Right-click the assembly that 
will receive the component and use the 
contextual menu to insert the component. 

B. Product Structure: Tools Select the assembly 
in the specification tree and use the icons in the 
Product Structure Tools.

C. Insert menu: Select the assembly in the 
specification tree and use the Insert menu.

When you add existing parts or assemblies as 
components, their corresponding files are not 
copied into the assembly; they are only referenced 
by the assembly. Once components are inserted 
into a product you can customize their display and 
their properties. 

Assemble in the Base Component
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After inserting the base component, it can be left 
to “float” in space (without constraints), but it is a 
good practice to fix this component. Fixing it will 
serve as a reference for placing all other 
components that are assembled later. Once you 
have fixed a component, you can still temporarily 
manipulate its location using the compass. 
Besides using the compass, components can be 
moved using the Snap tool. These changes are 
temporary and after updating the assembly, the 
constraint will be re-evaluated.
In addition to manipulating the position of 
components in geometry area you can reorder 
components in the specification tree to match 
your design requirements.
An assembly may require more than one 
instance of a component. The Copy and Paste 
options provide an easy way to duplicate a 
component. 

Manipulating 
orientation of entire 
assembly.

Manipulating position 
of a component in an 
assembly.

Manipulate the Position of the Component
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When components are first inserted into assembly, 
they can be translated and rotated in any direction. 
As constraints are applied to the component, the 
degrees of freedom decrease. Similar to sketching 
constraints, the assembly constraints also locate a 
geometry that is relative to the existing features. 

Use the following general steps to add the 
assembly constraints:

1. Fix one component in space in the assembly. 
2. With the compass, drag and rotate 

components to their approximate positions. 
3. Position each component precisely by 

selecting and applying the appropriate 
constraints. 

4. To control the result, update the assembly. 

1 2

34

Assemble & Fully Constrain Components
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The following four options (found in the File menu) 
can be used to save the assembly and child 
documents:

A. The Save option saves the active component 
children of the active document.

B. The Save As option is similar to Save, except 
that you can also specify a name and a folder 
for the active document.

C. The Save All option saves all the open 
documents that have been modified since the 
last save.

D. The Save Management option prompts you to 
save all the open documents and children of 
these documents; you can also control their 
names and locations.

Save the Assembly
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1

2

3

4

Product Structure tools

Add components: adds existing components 
such as parts, subassemblies etc. to a Product

Graph tree Reordering: reorders components 
in the specification tree to meet your needs

Fast Multi Instantiation: repeats components 
using the parameters previously set in the 
Define Multi Instantiation command

Define Multi Instantiation: repeats 
components as many times as you want in the 
direction of your choice

Move

5 Snap: snaps one component over another with 
reference to selected faces

1

2

3

4

5

Assembly Design Tools
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1

2

3

4

Constraints

Coincidence Constraint: creates an alignment 
between two components that can be coaxial, 
coplanar, or merged points

Contact Constraint: connects two planes or 
faces

Offset Constraint: defines the distance 
between two elements

Angle Constraint: defines the angular distance 
between two elements

Fix Component: prevents the component from 
moving from its position during the update 
operation

Fix Together: enables you to constrain 
components so that, they move as a single 
entity

7 Reuse Pattern: duplicates a component 
reusing a pattern created in the Part Design 
workbench

1

2

3

4

5

7

6

5

6

Assembly Design Tools
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Exercise: Reuse Components
Recap Exercise

20 min

In this exercise you will practice reusing the patterns. High-level instructions for this 
exercise are provided.

By the end of this exercise you will be able to:

Use the Reuse Pattern tool

Copy and paste a component



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 223

Do it Yourself (1/3) 

1

2

1. Load Exercise10B.CATProduct.

2. Instantiate VISD8.CATPart using Reuse 
Pattern.

Using Rectangular pattern defined in the 
Engine_support_pattern.catpart, 
instantiate VISD8.CATPart.



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 224

Do it Yourself (2/3) 

3

3

3. Create instance of VISD8.CATPart. 
Copy VISD8.CATPart and paste it in 
the root product.
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Do it Yourself (3/3) 

4

4. Manipulate the position of new 
instance using the compass.

Drag and drop the compass on the 
pasted instance and manipulate 
the position.

5. Close the assembly without saving it.
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Exercise Recap: Reuse Components

Use the Reuse Pattern tool

Copy and paste a component
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Exercise: Component Positioning
Recap Exercise

10 min

In this exercise you will use the tools used in the previous exercises to 
create a new assembly. 

By the end of this exercise you will be able to:

Create a new product

Add a component into the assembly

Position the component using manual methods
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Do it Yourself
1. Insert the cric_frame.catpart first and fix 

it in space. 

2. Insert cric_branch_3.catpart and 
cric_branch_1.catpart, then move them 
into the positions shown.
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Exercise Recap: Component Positioning

Create a new product 

Add a component into the assembly

Position the component using manual methods
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Exercise: Constraints Creation
Recap Exercise

20 min

In this exercise you will continue to practice assembling and constraining 
components while building an assembly. High-level instructions for this exercise are 
provided.

By the end of this exercise you will be able to:

Create a Contact constraint

Create an Offset constraint

Create a Coincidence constraint

Create a Parallelism constraint



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 231

Do it Yourself (1/4) 

1. Create new product.

2. Save the file and specify [Stand] as the 
name.

3. Insert Base.CATPart and apply a Fix 
constraint.
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Do it Yourself (2/4) 
4. Insert Column.CATPart and apply a 

Contact constraint.

5. Apply a Coincident constraint.

6. Update the assembly and view the 
structure and constraints.
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Do it Yourself (3/4) 
7. Insert Table.CATPart and position it 

with the compass as shown. 

8. Apply a Coincident constraint.
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Do it Yourself (4/4) 
9. Apply an offset constraint. Specify [450] 

as the offset value.

10. Apply a parallelism constraint.

11. Save the product file.
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Exercise Recap: Constraints Creation

Create a Contact constraint

Create an Offset constraint

Create a Coincidence constraint

Create a Parallelism constraint
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Exercise: Degrees of Freedom
Recap Exercise

20 min

In this exercise you will troubleshoot an existing assembly and determine which of its 
components are not fully constrained. You will use the tools used in the previous 
exercises to complete this exercise. 

By the end of this exercise you will be able to:

Determine the degrees of freedom of a component

Fully constrain a component

Conf. Dep.
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Do it Yourself

Open Troubleshoot.CATProduct and determine which components in the assembly 
are not fully constrained. Create the constraints necessary to fully constrain the 
components of the assembly. 

Conf. Dep.
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Exercise Recap: Degrees of Freedom

Determine the degrees of freedom of a component

Fully constrain a component

Conf. Dep.
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Case Study: Assembly Design
Recap Exercise

20 min

You will practice what you have learned by completing the case study model 
using only a detailed drawing as guidance.

In this exercise you will create the case study model. Recall the design intent of 
this model:

First component is fixed 

All the components are fully-constrained

Duplication tools are required

Using the techniques discussed so far, create the model 
without detailed instructions.
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Do It Yourself: Drawing of the Handle Mechanism
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Case Study: Handle Mechanism Recap

First component is fixed 

All the components are fully-constrained

Duplication tools are required
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Designing in Context

Open an Existing Assembly
Insert a New Model
Create a Sketch in Context
Create Assembly-Level Features

4 Hours

9
Learning Objectives
Upon completion of this lesson you will be able to: 
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The case study for this lesson is the Chuck part 
used in the Drill Support assembly.

Design Intent

The model must be created within an assembly.
The base feature sketch support should refer a 
reference plane from another model.
The axis of revolution for the shaft should be 
coincident with the axis of the base component.
The chuck geometry will be used to define the 
volume within the canella_axis.

Case Study

1. Open an Existing Assembly
2. Insert a New Model
3. Create a Sketch in Context
4. Create Assembly-Level Features

Stages in the Process
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Assemblies can contain components that 
reference individual parts and assembly files. If 
referenced files are moved from their original 
locations, CATIA may not be able to locate them 
when the top-level assembly is retrieved. CATIA 
prompts you to specify the new locations of the 
missing files. Using the Desk command, you can 
locate these files. 
By default, the assemblies and their components 
are loaded into a CATIA session in Design mode. 
In this mode, the part definition of all the 
components are loaded into memory. The loading 
time may be large. To improve performance, 
assemblies can be loaded in the visualization 
mode, where CGR representations of the 
geometry are loaded instead of the actual 
geometry. 

Visualization mode

Design mode

Product opened in 
Visualization mode

A

B
C

Open an Existing Assembly
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A.Part: Create a new part file that exists as a 
separate file.

B.Product: Create a new product or sub-
assembly that exists as a separate file.

C.Component: Create a new product that exists 
only in the top-level assembly.

As mentioned in the previous lessons, CATIA 
enables you to insert previously created 
components into an assembly. New models can 
also be created directly in an assembly. You can 
create the following types of models:

A

B

C

Insert a New Model
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While working in context of an assembly you can 
make use of the existing components in one of the 
following ways:

As a general rule when designing in context, the 
components created within the context of an 
assembly is unique to the assembly and should 
not be inserted into another assembly nor moved 
to another position. However, if the components 
have to be moved as per the design requirement, 
you must break the external references. This is 
done by isolating the feature.

A. Sketching on a face of a component
B. Projecting / intersecting 3D elements onto the 

sketch plane 
C.Defining sketch constraints using other 

components
D.Limiting features up to other components

A

B

C

D

Face of existing 
component used 
to create a sketch

Coincident 
constraint between 
sketch entity and 
existing edge

Edge created using 
intersection

Pad limited by 
existing face

Create a Sketch in Context
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Assembly features are created inside an 
assembly and these features affect not only a 
single part but a set of components of the 
assembly. These features include: split, hole, 
pocket, add, remove, and symmetry.
Assembly-level split, hole, and pocket features 
can be created based on the same type of 
features that exist in the child component. 
These features cannot be patterned. 
Assembly-level hole features appear in the 
assembly specification tree and the part 
specification tree in which it is applied. This is 
because, the hole dimensions are modified at 
the assembly level, but their position is modified 
at the part level. 

Engine 
Component

Pulley 
component

Assembly level hole feature 
affects engine as well as pulley.

Assembly-level hole features in the 
assembly specification tree and the 
part specification tree

Create Assembly-Level Features
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1

2

3

4

Assembly Features

Split: splits one or more components using the 
splitting surface in a single operation

Hole: creates a hole passing through multiple 
components in a single operation

Pocket: creates a pocket passing through 
multiple components in a single operation

Add: adds a part body to multiple components 
in a single operation

Remove: removes material from all the affected 
components using geometry of a part body in a 
single operation

5

File Menu

6 File > Desk: helps to locate the missing files 
referenced by an assembly loaded in the 
session

1

2

3

4

5

Design in Context Tools
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Exercise: Visualization and Design Modes
Recap Exercise

25 min

In this exercise you will open an existing assembly and change between the 
Visualization and Design modes, make modifications to a component, and switch 
back to Visualization mode. High-level instructions for this exercise are provided.

By the end of this exercise you will be able to:

Open an existing assembly in Visualization mode

Change between the Visualization and Design 
modes

Modify a component
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Do it Yourself (1/2) 

1

23

1. Open the file Ex9B.CATProduct.
Verify that the Work with the cache 
system option is activated for this 
exercise.

2. Locate the missing files using the Desk
command.

3. Switch all the components to Design mode.
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Do it Yourself (2/2) 

4

5

6

4. Modify the diameter of the Column from 
[80mm] to [75mm].

5. Modify the diameter of hole.1 in the Base 
component from [80mm] to [75mm].

6. Switch the Table.1 and Table_Handle.1 
components back to Visualization mode.
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Exercise Recap: Visualization and Design Modes

Open an existing assembly in Visualization 
mode

Change between the Visualization and 
Design modes

Modify a component
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Exercise: Design in Context
Recap Exercise

20 min

In this exercise, you will construct the Engine Axis part within the Bloc_Engine 
assembly. High-level instructions for this exercise are provided.

By the end of this exercise you will be able to:

Create a new part within an assembly

Create a part geometry referencing other components in the assembly

Modify the geometry of a source and update the target component
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Do it Yourself (1/5) 

1

2

1. Open the file Ex9D.CATProduct.

2. Insert a new part file and make it the active model.
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Do it Yourself (2/5) 
3. Create a shaft inside the new part with the following 

sketch.
• Create the sketch on the zx plane that exists in the engine part.
• Use Intersect 3D elements to create an external reference between 

the surface of the hole and the profile.
• Use Project 3D elements for the creation of the axis and the vertical 

side of the profile.
• Inside the Sketcher workbench, select the Cut Part by Sketch 

Plane icon from the Visualization toolbar, to better view the part.

3
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Do it Yourself (3/5) 

4

4. Create a hole using the criteria shown.
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Do it Yourself (4/5) 
5. Create a pocket as shown.
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Do it Yourself (5/5) 

6

7

6. Activate the Engine part and modify the hole.4 
diameter from 28mm to 30mm.

7. Update the assembly.
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Exercise Recap: Design in Context

Create a new part within an assembly

Create a part geometry referencing other components in the assembly

Modify the geometry of a source and update the target component
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Exercise: Design in Context
Recap Exercise

20 min

In this exercise you will create a part in the context of the assembly then compare it 
with an existing model where the components were created separately. You will use 
the tools you have learned in this lesson to complete the exercise with no detailed 
instructions.

By the end of this exercise you will be able to:

Create a part within the context of an assembly

Understand some of the differences between the two design 
approaches
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Do it Yourself (1/2)
1. Open Ex9E.CATProduct and create the following engine support in the context of 

the assembly. Reference the engine component while creating the engine 
support.
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Do it Yourself (2/2)
2. Open Bloc_Engine.CATProduct and 

compare this model with the part you 
created. Investigate the following:

A. Can geometry changes made to the 
engine part cause geometry changes in 
the engine support?

B. Are you able to move the components 
using the compass in an assembly?

C. What happens if the engine part is 
deleted?
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Exercise Recap: Design in Context

Create a part within the context of an assembly

Understand some of the differences between the two 
design approaches

A. Can geometry changes made to the engine part cause 
geometry changes in the engine support?

With Bloc_Engine.CATProduct, the only references that 
exist between the components are through assembly 
constraints, which cannot modify the actual geometry.

B. Are you able to move components using the compass in 
an assembly?

You are able to move components in both assemblies; 
however, you will be breaking the assembly constraints in 
the Bloc_Engine.CATProduct. The components need to be 
isolated before they can be moved.

C. What happens if the engine part is deleted?
In Ex9E.CATProduct the engine support will lose 
references that were used to create its geometry. The part 
will open, but features that reference the engine will not be 
modifiable.
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Case Study: Designing in Context
Recap Exercise

25 min

You will practice what you learned by completing the case study model using 
only a detailed drawing as guidance.

In this exercise you will create the case study model. Recall the design intent of 
this model:

The model must be created within the assembly.

The base feature sketch support should reference a datum plane from another model. 

The axis of revolution for the shaft should be coincident with the axis of the base component.

The Chuck geometry will be used to define the volume within the Canella_axis.

Using the techniques discussed so far, create the model 
without detailed instructions.
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Do It Yourself: Designing in Context (1/2)

1. Open the supplied file CS-L9.CATProduct 
from the case study directory.

2. Insert a new part into the assembly.
3. Create the revolved base feature.
4. Create a pocket to define a cut.
5. Mirror the pocket.
6. Create a pocket to define one of the 

ridges.
7. Pattern the pocket as a complete crown.
8. Create an assembly-level hole.
9. Perform a Remove Boolean operation at 

the assembly level to remove the Chuck 
part from the Canella_axis component.

You must complete the following tasks:
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Do It Yourself: Designing in Context (2/2)

4

5

6

7

8
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Case Study: Chuck Recap

Insert a new part into the 
reference assembly.

Create a revolved base feature.

Create a pocket to define a cut.

Create a pocket.

Pattern the pocket.

Create an assembly-level hole.

Perform a remove at the 
assembly level that removes the 
Chuck part from the barrel 
component.
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Drafting (ISO)
Learning Objectives
Upon completion of this lesson you will be able to: 

Start a New Drawing
Create Views
Create Dimensions and Annotations
Create Additional Views
View Modifications
Save the Drawing
Print the Drawing

2 Hours

10
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The case study for this lesson is the drawing of 
base part used in the Drill Press assembly.

Design Intent

The drawing should be created using an ISO 
standard.
The drawing should contain one view that 
shows hidden lines and axis.
The drawing should contain a title block.

Case Study

Stages in the Process

1. Start a New Drawing
2. Create Views
3. Create Dimensions and Annotations
4. Create Additional Views
5. View Modifications
6. Save the Drawing
7. Print the Drawing
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The 3D environment gives designers a very efficient 
and flexible tool to create parts and assemblies. 
However, it is often necessary to communicate the 
manufacturing information with 2D drawings. Once 
a new drawing is started you are prompted to define 
the properties of the drawing. 
Sample CATDrawing files corresponding to the 
organization standards can be stored at the central 
location. These files contain Title Blocks of the 
organization and drafting standards 
To use these files to start new drawings, select “File 
> New from” command.

Start a New Drawing

A. Title Blocks of the organization, which may 
contain information such as name of the 
organization, part number, etc.

B. Drafting standards such as dimension styles, 
line types, etc. 
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Create Views

A.Associative: (linked to 3D models), which are 
called Generated Views. 

B.Non-associative: (not linked to 3D models), 
which are called Draw Views.

Views represent different orientations of a part, 
which help to convey its design intent. Two types of 
views can be created in CATIA:

The View Wizard enables you to quickly create 
different views in one operation. Among different 
modes of view generation exact view generation 
mode is the best option in many cases. For 
creating views of large assemblies you can use 
CGR mode.

A

B
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Dimensions define the size and functional intent of 
a part and are often used to create a fabrication 
drawing for a manufacturer.

You can control the display of dimensions using 
the Dimension Properties such as dimension line 
style, tolerance formats, etc. and Numerical 
Properties such as numerical display, precision.
In addition to creating dimensions in a drawing, 
you can add notes and annotations to it using Text 
Toolbar. 

You can create dimensions either using tools 
dedicated to the type of dimension you want to 
create; length/distance, angular, radius, diameter, 
etc. or you can use general dimensioning tool, 
CATIA interprets the elements you select, and 
creates a Length/ Distance, Angular, Radius, or 
Diameter dimension “automatically” for you.

general 
dimensioning 
tool

Create Dimensions and Annotations
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Secondary Views are added to improve the clarity 
of the description of a part through better 
visualization and/or to aid in dimensioning.

A.Section View: created by cutting the solid by 
section plane

B.Detail View: created by defining a "callout" on 
an existing view around the area to be enlarged, 
creates new view 

C.Clipping View: created by defining a "callout" 
on an existing view around the area to be 
enlarged, modifies existing view

D.Broken View: defined by adding break lines to 
determine an area of the view that will be 
removed

E. Breakout View: created by cutting the solid 
locally order to see the inside of a part 

F. Auxiliary View: created in a given direction that 
cannot be obtained with a standard view

A B C

Create Additional Views

D E F
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A. To modify the position of a view: Select the view 
frame and drag to move it to another location. 

B. To delete the unnecessary views: Select the 
view frame and select Edit > Delete.

C. To modify the properties of a view: Select the 
view frame and select Properties from the 
contextual menu.

D. To change the content of a view: Select the view 
frame and select Modify Links from contextual 
menu.

E. To change the definition of the projection plane 
of a view: select Modify Projection Plane from 
the contextual menu. 

F. To change the section profile definition use the 
Edit /Replace toolbar.

To modify a view use the following steps:

changing the 
content of a 
view

View Modifications
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1

2

3

4

Drafting Toolbars

Views: create different kinds of views

Drawing: create sheets, views, 2D components 
and frame title blocks

Dimensioning: create all types of dimensions 
needed to complete drawing

Generation: generate dimensions and balloons

Annotations: add annotations to existing views 

Dress-Up: add dress-up elements on the 
drawing

Geometry Creation: creates 2D geometry 
elements such as points, lines, planes, circles 
etc.

Geometry Modifications: transform existing 
2D elements and add constraints to elements 
on the drawing

1

2

3

4

5

5

6

6

7

8

7

8

Drafting Tools
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Exercise: Drawing Creation
Recap Exercise

20 min

In this exercise you will create a drawing using ISO standard. High-level instructions 
for this exercise are provided.

By the end of this exercise you will be able to:

Create a drawing

Insert a title block using catalog

Create views using the view wizard

Move and delete views

Dimension geometry
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Do it Yourself (1/3) 

1
1. Load Ex12B.CATPart .

2. Create a new drawing.
Use the A2 and standard ISO drawing 
size.

3. Insert a title block using catalog. 
Insert ISO_A2 from 
Catalog_Title_Blocks.catalog.
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Do it Yourself (2/3) 

4

5

4. Use the view wizard to create views.
Place the pre-defined layout of 
Configuration 6 with a third angle 
projection.

5. Move and delete some views.
Delete the top, bottom, and rear 
views.
Position the views so that they 
appear evenly spaced out in the 
drawing.
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Do it Yourself (3/3) 
6. Dimension and annotate the drawing as shown.
7. Close the drawing without saving.
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Exercise Recap: Drawing Creation

Create a drawing

Insert a title block

Create views using the view wizard

Move and delete views

Dimension geometry
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Exercise: Drawing Creation
Recap Exercise

20 min

In this exercise you will use the new skills you have gained to create a drawing of a 
jewel case part.  You will use the tools used in the previous exercises to complete 
this exercise without any detailed instruction. 

By the end of this exercise you will be able to:

Create a new drawing

Insert a title block

Add views 

Dimension and annotate the drawing

Save the drawing
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Do it Yourself  
1. Create drawing of the Jewel_Case_Done part, as shown.
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Exercise Recap: Drawing Creation

Create a new drawing

Insert a title block

Add views

Dimension and annotate the drawing

Save the drawing
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Case Study: Drafting
Recap Exercise

20 min

You will practice what you learned by completing the case study model using 
only a detailed drawing and hints as guidance.

In this exercise, you will create the case study model drawing. Recall the design 
intent of this model:

The drawing should be created using an ISO standard.

The drawing should contain one view that shows hidden lines and the axis.

The drawing should contain a title block.

Using the techniques you have learned in this and previous 
lessons, create the model without detailed instruction.
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Do It Yourself: Drawing of the Base Part
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Case Study:  Base Recap

The drawing should be created using an ISO 
standard.

The drawing should contain one view that shows 
hidden lines and the axis.

The drawing should contain a title block.
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Master Project
Drill Press Assembly

30 min

The objectives of this project are to create a part, analyze it, add the part to an 
assembly, modify the part within the context of the assembly, and to create an 
assembly drawing. The assembly used in this project is the Drill Press. You have 
created several components used in the assembly in case studies throughout 
the course.

Create the support part for the assembly
Finalize the part
Create the drill press assembly
Edit a part within the context of the assembly
Create a drawing of the Drill Press assembly

By the end of this project you will be able to:
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Master Project: Overview (1/3)

Following is a list of steps that are required 
to complete the master project:

1. Create a part.
Create the support used in the Drill Press 
assembly. The part uses features learned 
in this course.
Design Intent:

A stable base feature must be selected.
The model must be created 
symmetrically about the YZ and the ZX 
planes, and must sit on the XY plane.
Fillets must be created as separate 
features (they cannot be created within 
the profile sketches).
Avoid complicated profiles.
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Master Project: Overview (2/3)

2. Finalize the part.
Apply material and take measurements of 
the model. 
Design Intent:

The model must be made of aluminum.
Overall dimension, the mass and center 
of gravity must be clearly displayed on 
the model.
The length of the model must be double 
the width of the model.
A parameter must be created to control 
the length of the model.

3. Create the Drill Press assembly.
Using the models you have built in the 
case studies, and additional models, 
create the Drill Press assembly. 
Design Intent:

Select the most stable base component.
Fully constrain all the components in the 
assembly.
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Master Project: Overview (3/3) 
4. Modify a part in the context of the 

assembly.
Make changes to the support within 
the context of the assembly. 
Design Intent:

The diameter of the hole must update 
when changes are made to the 
handle block.

5. Create an assembly drawing.
Create a simple assembly drawing of 
the Drill Press assembly. 
Design Intent:

Three main views of the drawing 
must be shown.
Overall dimensions for the Drill Press 
must be displayed on the drawing.
The drawing must contain a title 
block.
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Master Project: Overview Recap

Create the support

Finalize the part file

Create the Drill Press assembly

Edit a part within the context of the assembly

Create an assembly drawing
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Master Project: Part Creation
Drill Press Assembly

60 min

The objective of this step is to plan and create the support part. The support part 
is a part of the Drill Press assembly. High-level instructions for this exercise are 
provided.

Create a new part
Determine the best base feature
Determine the best tool for each feature
Save a file

By the end of this step, you will be able to:
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Master Project: Part Creation (1/10) 

Detail views on the next page.

Create the support part.
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Master Project: Part Creation (2/10) 
Create the support part (continued).
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Master Project: Part Creation (3/10) 

1. Create a base feature.
Select a stable base feature. For the 
support, a simple block shape is best. 
Create the block so that the bottom of 
the block is located on the XY plane, 
and the box is symmetric about the YZ 
and ZX planes.

2. Remove material.
Remove the material using a pocket 
feature.

3. Create cylindrical pad.
Create the top cylinder using a pad 
feature. This feature could also be 
constructed with a shaft. What are the 
benefits of using a pad?

Here is a list of tasks to guide you:

1

2

3
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Master Project: Part Creation (4/10) 

4. Remove side material.
Remove the side material using a 
pocket feature.

5. Remove material from the other side.
Remove the material from the other 
side by mirroring the pocket created 
in step 4 about a reference plane.

6. Apply 1degree draft to the cylindrical 
surface.

Apply a 1 degree draft to side 
surface of the cylindrical pad. Use 
the bottom surface of the block as 
the neutral element. Make sure the 
pull direction appears as shown.

Here is a list of tasks to guide you 
(continued):

4

5

6
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Master Project: Part Creation (5/10) 

7. Apply a 1 degree draft to the sides of the 
base.

Apply a 1 degree draft to 8 side 
surfaces of the block. Use the bottom 
surface of the block as the neutral 
element. Make sure the pull direction 
is as shown.

8. Create Pad.
Create a pad through the block. 
Create the pad in the center of the 
block, then extrude in both the 
directions equally.

9. Apply fillets to the model.
Apply fillets to the model. All fillets 
must be 5mm.

Here is a list of tasks to guide you 
(continued):

7

8
9
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Master Project: Part Creation (6/10) 

10. Create lip.
Create the lip at the base of the block 
by offsetting the bottom surface of the 
block in the Sketcher workbench. 
Recall the design intent: the bottom of 
the support must sit on the XY plane.

11. Shell the model.
Shell the model leaving a 5mm inside 
thickness. Remove the two surfaces 
as shown.

12. Create a hole.
Create a 70mm diameter hole at the 
top of the block.

Here is a list of tasks to guide you 
(continued):

10

11

12
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Master Project: Part Creation (7/10) 

13. Create a stiffener.
Create a stiffener in the center of the 
support.

14. Create 1 degree draft on stiffener.
Apply a 1 degree draft to the sides of 
the stiffener. Use the bottom surface 
of the support as the neutral element. 
Ensure that the pull direction appears 
as shown.

15. Create edge fillets on the four edges.
Add 5mm edge fillets to the inside 
four edges of the stiffener as shown.

Here is a list of tasks to guide you 
(continued):

13

14

15
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Master Project: Part Creation (8/10) 

16 17

18

16. Create a Tritangent fillet.
Add a tritangent fillet to the 
stiffener.

17. Create edge fillets on the two outside 
edges of the stiffener.

Complete the stiffener by adding 
5mm edge fillets to the end edges.

18. Create and pattern a hole.
Create an 8 mm diameter hole on 
the lip of the support and use the 
Rectangular Pattern tool to create 
the other three holes.

Here is a list of tasks to guide you 
(continued):
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Master Project: Part Creation (9/10) 

Front Face 
reference

Side Face 
reference

19

19. Add two cataloged features.
The tabs have been created for you and are located in 
the Tabs.Catalog file. Use the references for the user 
feature as shown. 
Create two planes as the sketch support reference. The 
first plane is offset from the XY plane 50mm, the second 
plane is offset 170mm from the XY plane.

Here is a list of tasks to guide you (continued):
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Master Project: Part Creation (10/10) 

20

20. Add edge fillets to both tabs and lip edge.
Finish the model by adding 5mm 
fillets to the tabs and the edge 
between the lip and the block.

Here is a list of tasks to guide you 
(continued):
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Master Project: Part Creation Recap

Create a new part
Determine the best base feature
Determine the best tool for each feature
Save a file
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Master Project: Finalize the Part
Drill Press Assembly

60 min

The objective of this step is to finalize the support part. Material will be applied, 
measurements will be taken, and formulas will be developed. High-level 
instructions for this exercise are provided.

Apply material to the model
Save overall length and width measurements
Calculate the mass of the model
Locate the center of gravity
Create formulas

By the end of this step, you will be able to:
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Master Project: Finalize the Part (1/4)

Lengthwidth

Base Feature

1

2

1. Apply material to the model.
Apply aluminum to the model.

2. Create formula to control the width of the 
model.

Create a formula that equates the 
width of the model to ½ the length. 
Use the width and length dimension 
for the base feature.

Continue with the support part created in step 1. If 
you did not complete step 1, use 
Support_Step1.CATPart from the completed folder.

Here is a list of tasks to guide you:
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Master Project: Finalize the Part (2/4)

3

4

3. Add a user-defined parameter to the model.
Create a user-defined parameter of type 
[length]. Name the parameter [Length]. 
Give the parameter a value of [485mm].

4. Equate the length of the model to the user-
defined parameter.

Equate the length dimension to the new 
parameter. Test the parameter by 
changing the Length parameter value 
back to [480mm].

Here is a list of tasks to guide you 
(continued):
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Master Project: Finalize the Part (3/4)

5

6

5. Calculate the overall length, width and height 
of the model.

Calculate the measurements as shown. 
Customize the measurements to calculate 
the components. Save the measurements.

6. Determine the mass of the support.
Customize the Measure Inertia tool to only 
calculate mass. Save the measurement.

Here is a list of tasks to guide you 
(continued):
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Master Project: Finalize the Part (4/4)

7

7. Locate the center of gravity.
Create a point at the center of gravity using 
the Create Geometry option from the 
Measure Inertia window.

8. Hide the Geometrical set and the 
Measurements.

For clarity, hide the Geometrical Set.1 and 
Measure branches of the specification tree.

To help, here is a list of tasks (continued):
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Master Project: Finalize the Part Recap

Apply material to the model
Save overall length and width measurements
Calculate the mass of the model
Locate the center of gravity
Create formulas
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Master Project: Create an Assembly
Drill Press Assembly

60 min

The objective of this step is to create the Drill Press assembly. This assembly 
contains all the parts you have created in the case studies also the support part. 
High-level instructions for this exercise are provided.

Create a new assembly
Add components to the assembly
Fully constrain the assembly
Modify display properties
Save the file

By the end of this step you will be able to:
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Master Project: Create an Assembly (1/7)

Bloc_Engine
.CATProduct

Handle_Mechanism
.CATProduct

Drill_Support
.CATProduct

Stand.CATProduct

Casing_Sup.CATPart
Casing_Inf.CATPart

Support
.CATPart

1. Create a new assembly.
Create a new assembly. Name the 
assembly [Drill_Press].

2. Add the Stand.CATProduct.
The first component assembled into the 
file should be the most stable. In this 
case, the Stand sub-assembly is the 
best choice. Use the Fix constraint to 
fully constrain the component.

All sub-assemblies have already been created 
for you. The structure of the Drill Press 
assembly is shown.

Here is a list of tasks to guide you:
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Master Project: Create an Assembly (2/7)

3a

3b
3c

3. Insert Support.CATPart.
a. Add the Support to the assembly. If you did 

not complete step 2, use the 
Support_Step2.CATPart in the completed 
folder instead.

b. The inside bottom surface of the support 
should be on the same plane as the top of 
the column.

c. The ZX plane in the support should be 
parallel with the side of the table.

d. The axis of the pad on the support should 
be coincident with the axis of the column.

Here is a list of tasks to guide you 
(continued):
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Master Project: Create an Assembly (3/7)

4a

4b

4c

4. Insert Bloc_Engine.CATProduct.
a. Make the surface of the Engine support parallel 

with the YZ plane in the support.
b. Make the axis of the hole coincident with the 

hole in the tab on the support.
c. The bottom surface should be in contact with the 

top surface of the tab.

Here is a list of tasks to guide you (continued):
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Master Project: Create an Assembly (4/7)

5a

5b

5. Insert Drill_Support_L9.CATProduct.
a. Align the axis of the Canella_Axis with the 

axis of the hole in the support.
b. Make the side of support plaque parallel to 

the side of the side of the table.

Here is a list of tasks to guide you 
(continued):
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Master Project: Create an Assembly (5/7)

6c

6a

6b

6d

6. Insert Handle_Mechanism.CATProduct.
a. Make the axis of the handle block coincident 

with the axis in the circular pad on the 
support.

b. Make the bottom surface on the revolved 
feature in the handle block in contact with 
the circular pad on the support.

c. Make the top surface of the connecting rod 
parallel to the top surface of the support.

d. Add an external line contact constraint, 
using the surface contact tool between the 
circular surface of the bearing and the top 
surface of the support plaque.

Here is a list of tasks to guide you 
(continued):
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Master Project: Create an Assembly (6/7)

7b 7a
7c

8a

7. Add Casing_inf.CATPart.
a. Make one of the center holes in the casing 

coincident with the axis of the Canella axis.
b. Make one of the outer holes coincident with 

the corresponding hole on the support. 
c. Have the bottom surface of the casing in 

contact with the top surface of the support.

8. Add Casing_sup.CATPart.
a. Use the default reference planes on both 

the casing parts to fully constrain the 
component as shown.

Here is a list of tasks to guide you 
(continued):
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Master Project: Create an Assembly (7/7)

9a

9b

10

9. Insert Canella_Pulley.CATProduct.
• For clarity, hide the support, and both the casing parts from display. 

a. Make the axis of the pulley support with the axis of the canella axis.
b. Make the top surface of the pulley coincident with the top surface of 

the pulley in the Bloc_Engine.

10.Modify the display.
• Re-display all the components in the assembly. Hide all the constrains 

and visible reference planes if any.

Here is a list of tasks to guide you 
(continued):
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Master Project: Create an Assembly Recap

Create a new assembly
Add components to the 
assembly
Fully constrain the 
assembly
Modify display 
properties
Save the file
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Master Project: Edit a Part in an Assembly
Drill Press Assembly

40 min

Edit a part in the context of the assembly
Create a feature using references from other 
components in the assembly

By the end of this step you will be able to:

The objective of this step is to use the skills learned in this course to add a feature to the 
support part in the context of the assembly. Currently, there is no hole on the support for 
the handle block to the inserted. In this step, you will create the hole by referencing the 
diameter of the handle block. High-level instructions for this exercise are provided.
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Master Project: Edit a Part in an Assembly (1/2)

1

2

1. Activate the support part.
To create a feature inside the support 
model, the model must be active.

2. Create profile.
Create a profile by projecting the edges of 
the handle block. This ensures that the 
diameter of the hole is always correct. To 
create the projection, rotate the model to 
3D orientation, select the cylindrical 
surface, and use the Intersect 3D 
elements tool.

Continue with the Drill Press assembly created 
in step 3. If you have not completed step 3, 
use Step3_complete.CATProduct instead.

Here is a list of tasks to guide you:
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Master Project: Edit a Part in an Assembly (2/2)

3

4

3. Remove material.
Use a pocket feature to remove the 
material from the support.

4. Reactivate the assembly.
Reactivate the assembly. Re-display the 
components you may have hidden.

Here is a list of tasks to guide you 
(continued):
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Master Project: Edit a Part in an Assembly Recap

Create a new part
Determine the best base feature
Determine the best tool for each feature
Save a file
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Master Project: Create an Assembly Drawing
Drill Press Assembly

20 min

The objective of this step is to create a drawing of the drill press assembly. 
Include the overall dimensions of the model and a title block in the drawing. 
High-level instructions for this exercise are provided.

Create a new drawing
Create three main views
Add dimensions
Apply title block
Save a file

By the end of this step you will be able to:



CATIA V5 Fundamentals
STUDENT GUIDE

Copyright DASSAULT SYSTEMES 325

Master Project: Create an Assembly Drawing

• Standard: ANSI
• Format: C ANSI
• Orientation: Portrait
• Sheet Scale: 1:10
• Isometric view’s scale 1:15
• Title Block: 

Drawing_TitleBlock_Sample1.

Create a drawing of the drill press assembly 
as shown. If you have not completed step 4, 
use Step4_complete.CATProduct.

Use the following criteria:
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Master Project: Create an Assembly Drawing Recap

Create a new drawing
Create three main views
Add dimensions
Apply title block
Save a file
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Active Item (Assembly Design): The 
component which is being edited is called the 
active item. To make an item active, double-
click it. The active item will be highlighted.

Assembly Design: Creation of specifications 
for parts, constraints, and features in the 
context of an assembly. 

Assembly Features: Features created inside 
an assembly which affects more than one 
component of the assembly. 

Assembly: Assembly is a document that 
contains a collection of components. It has the 
file extension .CATProduct. An assembly is 
also called a product. 

Associative: A CATIA model is fully 
associative with the drawings and parts or 
assemblies that reference it. Changes in the 
model are automatically reflected in the 
associated drawings, parts, and/or assemblies. 
Likewise, changes in the context of the 
drawing or assembly are reflected back in the 
model. 

Catalogs: Catalogs are sets of frequently 
used features or components which are 
stored as a library of information. 

Compass: An orientation reference tool 
that helps while performing view rotations. 
The Compass is a powerful tool that can 
be used to physically move and 
manipulate objects. This is especially 
useful in Assembly Design, Freestyle, and 
Digital Mockup workbenches.

Component: A reference of a part or a 
subassembly integrated in an assembly. A 
component possesses characteristics 
related to how a referenced part or 
subassembly is integrated in an assembly. 

Constraints: Constraints establish 
geometrical or dimensional relationships 
between the features of a model by fixing 
their positions with respect to one another. 

Glossary
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Construction Geometry: Construction 
Geometry is created within a sketch to aid in 
profile creation. Unlike standard sketched 
geometry, construction geometry does not 
appear outside the Sketcher workbench. 

Design in Context: When a new part is created 
in an assembly, the new part features and 
sketches can be defined using geometry of 
existing components. This process is known as 
design in context. 

Design Intent: Design Intent is the plan of how 
to construct the solid model of a part in order to 
properly convey its visual and functional 
aspects. In order to efficiently use a parametric 
modeler like CATIA, you must consider the 
design intent before and while modeling the 
part. 

Design Mode: In this mode, the part definitions 
(exact geometry and parameters) of all the 
components in an assembly are loaded into 
memory. By default, the assemblies and their 
components are loaded into a CATIA session in 
the Design mode. 

Draft Angle: The angle that draft faces 
make with the pulling direction from the 
neutral element. This angle may be 
defined for each face. 

Drawing: A document which contains the 
geometrical information and specifications 
in form of 2D views. It has the extension 
as ‘.CATPart’. 

Dress-up Features: Features created 
directly on the solid model. Fillets and 
chamfers are examples of this type of 
feature. 
Explode: Command used to break down a 
pattern of features into number of 
individual features. 

Features: Elements that make up a part. 
They can be based on sketches (sketch-
based) or features that build on existing 
elements (dress-up and transformation). 
They can also be generated from surfaces 
(surface-based). 

Glossary
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Feature-based: Like an assembly is made up 
of a number of individual parts, a CATIA 
document is made up of individual elements. 
These elements are called features and the 
approach is called Feature-based.

Grid: A network of horizontal and vertical lines 
applied to the background of the Sketcher 
workbench, that provides coordinates for 
locating points. 

Instances (Assembly Design): Each 
component inserted into an assembly is a 
separate instance. For example, if the same 
part is inserted into an assembly twice, they will 
have the same part number but different 
instance numbers. No two components in an 
assembly can have the same instance number. 

In Work Object: It is the current state of the 
part during its design phase. It can be identified 
in the specification tree by its name, which is 
underlined.

Layered Approach: The layered 
approach builds the part one piece at a 
time, adding a layer or feature onto the 
previous one until the desired solution is 
obtained.

Manufacturing Approach: The 
manufacturing approach to modeling 
mimics the way the part would be 
manufactured.

Neutral Element: It is a plane or face 
which defines the neutral curve. The 
drafted surfaces pivot about a neutral 
curve.

Part Design: The workbench dedicated 
for designing parts using the solid 
modeling approach. 

Part Number: It identifies the part file 
used in the assembly. Normally, the part 
number is same as the file name for the 
components, at times, it may be different.

Glossary
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Part: A document which contains the 
geometrical information and specifications that 
define a 3D solid model. It has the extension as 
‘CATPart’. 

Part Body: Default container that contains the 
features that make up a part. 

Pattern: array of several identical features 
created from an existing feature. 

Positioned Sketch: Sketch for which you have 
specified the reference plane, origin, and the 
orientation of the absolute axis. 
Property: It is an attribute such as color or a 
name that can be assigned to any feature.

Potter's Wheel Approach: The potter's wheel 
approach builds the part as a single, revolved 
feature. A single sketch, representing the cross-
section, includes all the information and 
dimensions necessary to make the part as one 
feature. 

Pulling Direction: The direction from which the 
draft angle is measured. It derives its name from 
the direction in which the mold is pulled to extract 
the molded part.

Sketch-based features: Features created using 
a 2D sketch. Generally, the sketch is 
transformed into a 3D solid by extruding, 
rotating, sweeping, or lofting. 

Sketcher: The workbench dedicated for creating 
2D profiles with associated constraints, which 
can then be used to create 3D geometry.

Specification Tree: It keeps the hierarchy of 
features, constraints, and processes, and the 
assembly information for a CATIA document. 
The specification tree provides a visual step-by-
step record of the sequence followed while 
creating a solid model. 

Visualization mode: In this mode, CGR 
representations of the geometry, of all the 
components in an assembly, are loaded instead 
of the actual geometry. CGR (.cgr) files contain 
no geometry or part information; they are only a 
tessellated visual representation of the model. 

Glossary
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